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SECTION 1 

INTRODUCTION 
The Lesson Plan Editor (LPE) is an interactive utility, which allows users to create/edit lesson 
plans off-line on a portable computer (PC) or on the development workstation. A PC/workstation-
based editor with a Graphical User Interface (GUI) provides a user-friendly and familiar 
environment to the non-technical user. A GUI uses popup panels, scrollable lists, as well as 
mouse and keyboard inputs to ease lesson plan creation. 
 
Once created, the lesson plans can be transferred and installed into the simulator, then used 
during training at the instructor station. 
 
The following sections describe the Lesson Plan Editor in detail. 
 
Section 2 provides a list of references for use with this user guide. 
 
Section 3 provides a brief description of lesson plan concepts. Components making up a lesson 
plan are identified and described.  
 
Section 4 describes how to set up the editor, start the editor and the input and output files for the 
editor. 
 
Section 5 provides all the information required to get started on coding a lesson plan. This 
includes a brief description of windows concepts and interaction, and a detailed demonstration 
showing the coding of a lesson plan. 
 
Section 6 describes, in detail, the Lesson Plan Editor pull-down menu functions that are 
accessed from the Menu Bar.  
 
Section 7 describes, in detail, the Lesson Plan Editor convenience functions that can be 
accessed from the Tool Bar. 
 
Section 8 describes the Lesson Plan Editor window layout and modification procedures. This 
includes a description of the features of the Profile Edit Window. 
 
Section 9 gives a listing of all abbreviations used in this User Guide. 
 
Appendix A describes the Lesson Plan Editor Initialization file (LPUINIT.DAT). This includes 
general attributes, compulsory and optional keywords, and its proper syntax. 
 
Appendix B describes, in detail, how to code the Frame Database for the Lesson Plan Editor, 
which includes the frame definition, selection commands, instruction syntax and all related 
keywords. 
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SECTION 2 

REFERENCE DOCUMENTS 
 
[1] VIEWS II User Guide 
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SECTION 3 

LESSON PLAN CONCEPTS 
The lesson plans provide the framework for repeatable, structured, and efficient training sessions 
by grouping several actions into single lesson steps. 
 
A lesson plan sequences predefined steps of ground or in-flight activities performed by the crew. 
It also sets the environmental, ambient, and simulator conditions for these activities. The 
instructor selects these lesson plan steps during simulation. 
 

Lesson Plan Structure 
A lesson plan has two components: 
 
• Lesson Plan Index Page 
• Lesson Plan Pages 
 
The lesson index page displays all the lesson plans available for selection and allows the user to 
select a lesson plan. The lesson index page is not created using the Lesson Plan Editor but is 
coded as a regular LCD page. 
 
The lesson plan pages display the lesson steps that can be activated by the instructor. The 
instructor can follow the preprogrammed sequence of lesson plan steps or can select the steps in 
any order. The instructor can also deviate from the lesson plan to regular LCD pages. A lesson 
plan page may contain initial conditions, Automatic Terminal Information Service (ATIS) 
messages, steps, and comments. In addition, a profile lesson page may contain line/arrow 
graphics and popup buttons. 
 

Initial Condition Steps 
Initial Condition (IC) steps contain a set of functions whose corresponding values set the 
simulator to the state required for the subsequent steps to be performed. 
 

ATIS Messages 
The ATIS messages provide recorded information for arriving and departing aircraft, ambient 
conditions, and active runways. These messages are static text on lesson plan pages and are 
displayed in a different color from other information on the page. 
 

Steps 
A lesson plan step changes conditions on the simulator. Steps perform a variety of functions: the 
activation/cancellation of malfunctions, repositioning of the aircraft, changes in environmental, 
visual or aircraft conditions, system resets and freezes. 
 
The lesson plan steps may be coded to activate based on the satisfaction of a criterion (e.g., 
altitude > 10000 ft). In this case, a step is considered armed. The maximum number of criteria 
one can associate for each step is defined in LPUINIT.DAT file, using MAX_CRITERIA keywords. 
Up to 10 may be specified. 
  
The lesson plan steps may either be manually or automatically activated. Manual steps require 
instructor action to activate or arm (if criteria are specified on the step). Steps can also be 
activated automatically based on auto sequencing logic coded with the step. Automatic 
sequencing may consist of more than one condition, which can be related via logical AND or OR. 
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Comments 
Comments are text directives which complements the step and serves as static informative 
elements for the instructor. 
 

Line/Arrow Graphics 
The Line/Arrow graphics feature applies only to profile lesson pages. 
 
It provides visual representation of the expected flight profile, as well as an indication of when 
specific events will occur during the flight. 
 

Popup Buttons 
The Popup buttons are used to call up popups. This feature complements the lesson plan pages 
where alternative selections can be coded as direct input button within popup pages, meanwhile 
it provides additional information to the instructor. Activation of these direct inputs will not affect 
the flow of the lesson plan. 
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SECTION 4 

LESSON PLAN EDITOR SETUP AND 
OPERATION 

  
Input/Output Files Overview 

Figure 1 illustrates the input/output files used by the Lesson Plan Editor. The following sections 
describe the input and output files. 
 

Lesson Plan Editor

LPDIR.LST
[optional]

LPLNnnnn.lst
[optional]

LPAGnnnn.LST
[optional]

HISTORY.LST
[optional]

LPDB.DAT

PAGEnnnn.SRC

HISTORY.DAT

FRAME.ERR
[optional]

LPUINIT.DAT

FRAME.DAT
[REFER.LIB,
CATSEL.LIB,

MALF.LIB]

LPDB.DAT
[optional]

PAGEnnnn.SRC
[optional]

HISTORY.DAT
[optional]

 
 

Figure 1 Input/Output Files Overview 
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Input Files 
To run the Lesson Plan editor, the LPUINIT.DAT file is required, by default, in the current or 
working directory. 
 
If the user does not intend to have this file in the working directory, the file path and filename may 
be specified on the command line when the editor is run or on the icon property definition. 
 
LPUINIT.DAT is the initialization file for the Lesson Plan Editor. It specifies the pathnames for the 
following files: 
 
• FRAME.DAT 
• LPDB.DAT 
• Lesson plan page source files (PAGEnnnn.SRC) 
 
If FRAME.DAT is not in the directory specified in LPUINIT.DAT, the user gets an error when the 
utility is invoked and the execution is aborted.  
 
If LPDB.DAT does not already exist in the directory specified in LPUINIT.DAT, implying that no 
lesson plan exists yet, the utility will create an LPDB.DAT, and the user will begin with the empty 
lesson plan index. 
 

Lesson Plan Editor Initialization File (LPUINIT.DAT) 
The initialization file (LPUINIT.DAT) specifies the pathnames for the input files and the page 
source files, which constitute the output of the editor. 
 
This file also specifies certain general attributes for the lesson plan pages such as page 
attributes, desired touch box specifications and colors related parameters … etc. 
 
Refer to Appendix A for a complete description of the initialization file. 
 

Frame Database File (FRAME.DAT) 
The FRAME.DAT file contains all the selections available to code the lesson plans. The 
selections frame sequence appearing in LPE will be the direct result of the structure in this file. 
The user can organize the structure of the frames selections in any desired manner. It may make 
references to selections contained in the library files:  
 
• REFER.LIB 
• CATSEL.LIB 
• MALF.LIB 
 
Refer to the Frame Database User Guide (Appendix B) for more detailed information. 
 

Lesson Plan Database File (LPDB.DAT) 
This file is created by the Lesson Plan Editor and contains history information about all lessons 
and pages created using the editor. Each time the user updates or creates a lesson this file is 
updated.  
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Output Files 
The output from the Lesson Plan Editor is the page source files and the database file. The page 
source filenames are in the format PAGEnnnn.SRC, where nnnn is a number assigned by the 
editor in the range defined for the lesson plan pages. These source pages are the same as the 
regular LCD pages (see Reference 1, Section 2 for a more detailed description). Once these 
source files are transferred to the simulator host computer they are imported into Views (see 
Reference 1) for lesson display on the IOS. 
 

Listing Files 
The Listing files are created by the utility when a directory, preview or history listing is requested. 
The file formats are as follows: 
 
Directory Listing : LPDIR.LST 
 
Preview Listing : LPAGnnnn.LST 
(Lesson page)  where nnnn is the source page number 
 
Preview Listing : LPLNnnnn.LST 
(Lesson Plan)  where nnnn is the lesson plan number 
 
History Listing : HISTORY.LST 
 
There is also an error listing file generated when any object reference in the frame database 
cannot be found. 
Error Listing : Frame.err 
 

Foreground Update of Lesson Plans 
Updating the foreground with the source files created using the editor is accomplished using one 
of the following methods: 
 

Foreground Update by Diskette 
The user may copy the updated lesson plan(s) into the diskette and then transfer the source files 
into the host-designated directory (use VIEWS preferences dialog to define target folder). 
 
To copy a lesson plan into the diskette while in the Lesson Plan Editor, use the Copy To Disk 
action on the LP Pull-down, which will copy the highlighted/selected lesson plan pages, 
including the associated popup pages - if any.  
 
If the user does not wish to copy the lesson plan source to the floppy within the editor, the PC File 
Explorer can be used instead. 
 
  

Foreground Update by Ethernet 
The Ethernet File Transfer Protocol (FTP) is the most frequently used method and it is often used 
to transfer files from the PC workstation to the master pages directory of the host computer. The 
user needs to know which page source filenames to use when transferring. 
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Invoking the Editor 
To invoke the PC Lesson Plan Editor, position the cursor on the Standard LP Editor icon in the 
LPE window of the PC desktop and double-click the left mouse button on the icon. 
 
Once the editor is running, the CAE LOGO window appears. Select the OK button when 
prompted and then enter your name. The Lesson Plan Index window appears and the user may 
proceed to edit a lesson plan. 
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SECTION 5 

GETTING STARTED 
Lesson Plan Editor Window Concepts 

The following provides an overview of the window concepts and terminology used in this 
document. In addition, general interaction with the Editor via the mouse and keyboard is 
described. 
 
The primary user interface component of the Lesson Plan Editor is the window. A window (refer 
to Figure 2) consists of a Title Bar, a Border, a Menu Bar, a Tool Bar, a Client Area, a Status 
Area, buttons, and Scroll Bar. 
 

 
Figure 2 Window Components 
 
The Title Bar identifies a window to the user and is a cue to the user that the window may be 
moved. The Lesson Plan Editor has the following windows: 
 
• Logo window 
• Lesson Plan Index window 
• Lesson Plan Sub-Index window [optional]  
• Profile Edit window 
• Page Edit window 



  
User Guide Lesson Plan Editor 
 

Page 10 10018802  Revision 2 
 

Use or disclosure of this document is subject to the restriction 
on the title page of this document. 

The Menu Bar contains the actions (or commands) of the Editor. It is positioned right below the 
Title Bar. Actions that contain ellipses (…), call popup panels providing further interaction with 
the user. 
 
Also, a Tool Bar contains the frequently used functions, and is located below the Menu Bar. To 
move a popup panel, the user positions the mouse pointer on the popup panel Title Bar and 
drags the popup panel to the desired location. 
 
The client area is the focus of the user's attention. It contains the lesson plan components (e.g., 
lesson plan title, steps, text). 
 
The session status window at the bottom of the screen displays information about the present 
editing session. The information includes the page source number, and the row-column position 
of the cursor.  
  
Scroll bars provide the user with a cue that more information is available and the information 
may be scrolled into view via the Scroll Bar. 
 

Interaction 
Interaction with the Lesson Plan Editor is through the mouse and/or the keyboard. The Keyboard 
interaction consists of moving the keyboard cursor to a choice and selecting that choice. The 
cursor is moved by pressing the arrow keys, the tab keys, or by selecting <ALT> and the 
mnemonic for a choice. Selection is made by moving the cursor to a choice and pressing 
<ENTER> to select the choice. Selection is also possible via one character mnemonics. A 
mnemonic is underlined to provide the user with a visual cue as to which mnemonics may be 
used. 
 
The mouse interaction consists of moving the mouse pointer to a choice and selecting that 
choice. Selection is made by either single clicking, double clicking, or dragging selection with the 
left mouse button. 
 
Single Click: A single click on an object or item in a window selects the item. The selected 

item is highlighted in reverse video. Any further actions performed from either the 
Menu Bar or Tool Bar (e.g., delete or modify) will directly affect the selected 
item. 

 
Double Click: A double click selects an item and performs a default action. Double clicking on 

an item with the left button (for example, a step description) selects the item and 
allows the user to modify the item specifics (selections and criteria). This has the 
same effect as single clicking on the item and selecting Modify from the Edit 
pull-down in the Menu Bar. 

 
Dragging: Dragging consists of single clicking and moving the mouse pointer while keeping 

the left mouse button depressed. Dragging is terminated with the release of the 
mouse button and the selected item is dragged to the position upon releasing the 
mouse button. 
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The Menu Bar 
The actions performed on a selected function are selected from the pull-down menus accessed 
from the Menu Bar (refer to Figure 3). 
 
Actions, which are unavailable from a pull-down, are dimmed or displayed in reduced contrast 
(gray). 
 
Section 6 provides a complete description of the actions available from the Menu Bar. 
 

The Tool Bar 
The Tool Bar contains icons representing frequently used features (refer to Figure 3). 
 
NOTE: Section 7 provides a complete description of the actions available from the Tool Bar. 
 

 
Figure 3 Lesson Plan Editor Menu Bar and Tool Bar 
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Lesson Plan Coding Demonstration 
The following demonstrates how to code a lesson plan. This example shows the step-by-step 
creation and saving of a lesson plan page with two steps coded. A sample frame database is 
used to demonstrate the selection of simulator parameters and malfunctions (actual database 
may differ). 
 
STEP 1 Invoke the Lesson Plan Editor as described in Section 4. 
 

• The CAE logo window appears (refer to Figure 4).  
 

 

Figure 4 CAE Logo Dialog 
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STEP 2 Select OK. 
 

• The logo disappears and a popup panel appears requesting input of the user's 
name (refer to Figure 5). 

 
 

 

Figure 5 Name Popup Panel 
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STEP 3 Enter your name and select OK. 
 

• The popup panel disappears and the Lesson Plan Index window is in full view. 
 
STEP 4.1 Select a lesson index number in the client area to create the lesson plan. 
 

• The selected line of the corresponding lesson plan is highlighted. 
 
STEP 4.2 Select LP.. from the Create pull-down menu. 
 

• The Create LP popup panel appears (refer to Figure 6) with profile lesson as 
default. 

 
 

 
Figure 6 Create LP Popup Panel 
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STEP 5.1 Enter the lesson plan title and select OK. 
 

• The Grid Selection popup panel appears with the default grid type highlighted 
(refer to Figure 6). 

 
STEP 5.2 Choose a Grid type from the Grid Selection Popup and select OK (refer to Section 6 

for detail description of GRID information).  
 

• Both the popups disappear and the Profile Edit window appears with the page 
title and source page number. The Initial Conditions step is automatically 
created and its Detail window popup is opened automatically ready for the user 
to make step selections (refer to Figure 7). 

 

 

Figure 7 Profile Edit window with Initial Conditions Step and Detail window 
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STEP 6 Select the Parameter Selection.. button from the Detail window popup. 
 

• A list of available frames is displayed ready for user’s selection. 
 
STEP 7 Select the Initial Conditions frame from the list. 
 

• The Initial Conditions frame popup is displayed, showing all the selections that 
can be made from within it. 

 
STEP 8 Select the Default button from the popup. 
 

• All selections within the frame that possess a default value are automatically 
assigned that value (refer to Figure 8). 

 
 

 
Figure 8 Profile Edit window with Initial Conditions Frame 
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STEP 9 Select the Close button. 
 

• The Detail window now contains a list of the Parameters selected. These can be 
used as Step description on the page. 

 
STEP 10 Enter the step description in the upper text window and/or click on the selected 

parameters from the list. 
 

• The selected parameters are highlighted and the auto generated text is copied 
into the lower left area of the window (refer to Figure 9). 

 

 

Figure 9 Detail window with List of Auto-Generated Text 

 
 
STEP 11 Close the Detail window. 
 

• Both the manual text and the selected auto generated text are entered into the 
step (refer to Figure 10). 
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STEP 12.1 Select the Line button from the Tool Bar. 
 

• The Line button turns red indicating that the editor is in line draw mode, and user 
is now able to draw the profile for the lesson (refer to Figure 10).  

 
STEP 12.2 Move the cursor to the desired position in the graph and click on the left mouse 

button. 
 

• The line’s starting point is selected, the line is now “rubber-banded” as the cursor 
moves between the starting point and the current cursor position. 

 
STEP 12.3 Click on the left mouse button again at the next desired position.  
 

• The line is connected, the current cursor position now becomes the starting point 
for the next line and so on. 

 
STEP 12.4 Continue this process (repeat step 12.3) until the entire profile line is drawn.  
 
STEP 12.5 Click on the right mouse button (or select <ESC>) to end line drawing (but user 

remains in line draw mode). 
 
STEP 12.6 Deselect the Line button from the Tool Bar.  
 

• The Line button reverts from red to regular color. 
• The editor exits line draw mode. 

 

 
Figure 10 Profile Edit Window with Initial Conditions Step and Profile 



  
User Guide Lesson Plan Editor 
 

Page 19 10018802  Revision 2 
 

Use or disclosure of this document is subject to the restriction 
on the title page of this document. 

STEP 13.1 Select a point on the profile to create a step. 
 

• The selected profile line turns red.     
 
STEP 13.2 Select Step from the Create pull-down menu. 
 

• A new step is created (at the bottom left of the Profile Edit Window) and its Step 
Edit window is displayed ready for user to make selection. This detail window will 
show the step’s phase as well as its time and altitude (refer to Figure 11). The 
time and altitude of the step are calculated based on the position of the mouse 
click on the profile line. 

 

 

Figure 11 Profile Edit window with Detail Window Popup for Second Step 
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STEP 14 Select the Parameter Selection.. button and choose the Aircraft Conditions Frame.  
 

• The Aircraft Conditions frame is displayed.  
 
STEP 15.1 Select the CG selection. Enter a value using either the keyboard or the horizontal 

slider located at the bottom of A/C frame. (Refer to Figure 12.) 
 

• The selected value is reflected on the edit box on the right of the CG description.  
 
STEP 15.2 Select the Close button. 
 

• The A/C frame is closed and the selection is displayed in the detail list window. 
 
NOTE: Steps 14 to 15 can be repeated to code other selections for the step. 
 
 

 
Figure 12 Profile Edit window with Selection Popup Panels 
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STEP 16 Select the Parameter Selection.. button and choose the Malfunction Index Frame. 
 

• The Malfunctions frame is displayed with the malfunctions grouped together by 
Air Transportation Association (ATA) Chapter. 

 
STEP 17 Select Doors. 
 

• The corresponding Doors malfunctions appear at the lower portion of the 
malfunction frame. 

 
STEP 18 Select the AFT CARGO DOOR OPEN.  
 

• The malfunction is highlighted and set to ON (refer to Figure 13). 
 
NOTE:  Steps 17 and 18 may be repeated to code other desired malfunction selections for the 

current step. 
 
 

 
Figure 13 Profile Edit window with Malfunction Selections 
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STEP 19 Select the Close button. 
 

• The Malfunctions frame disappears and the malfunction is displayed in the Step 
Edit window. 

 
STEP 20 To select a criterion, the current step still highlighted, select Criteria.. button in the 

detail window.  
 

• The Criteria popup panel appears (refer to Figure 14). 
 
STEP 21 Select the Speed (Kts) criterion, enter a corresponding value (example 70.0), then 

select Increasing. Select Close button when done. 
 

• The criteria, direction, and value appear in the Criteria box of the Step Edit/Detail 
window. 

 
NOTE:  The steps 20 and 21 can be repeated to code more criterion for this step. 
 
 

 
Figure 14 Profile Edit window with Criteria Selection 
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STEP 22 Exit the Step Edit by selecting the Close button. 
 

• The Step Edit window disappears and the step text is displayed within the step. 
Also, the step is automatically placed near the profile and an arrow is drawn 
connecting it to the profile (refer to Figure 15). 

 
NOTE:  User may move the step by highlighting the step and dragging the mouse to the 

desired location, the arrow will be automatically updated without affecting the joining 
point of the arrow and profile.  

 

 
Figure 15 Profile Edit window with Second Step Coded 
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STEP 23 To exit and save the lesson plan, select Close.. from the File pull-down menu. 
 

• The Close popup panel appears (refer to Figure 16). 
 
 

 
Figure 16 Close Popup Panel 

 
 
STEP 24 Select the Save changes button. 
 

• The Close popup disappears and the Revision History popup panel is 
displayed (refer to Figure 17) 

 
 

 
Figure 17 History Popup Panel 

 
 
STEP 25 Enter revision history comment Test Lesson (refer to Figure 17) and select the OK 

button. 
 

• The user will be returned to the Lesson Plan Index window and the lesson plan 
will be saved. 
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SECTION 6 

LESSON PLAN EDITOR MENU BAR  
DESCRIPTION 
The Menu Bar 

The following is a description of the actions/commands available from the action or Menu Bar 
(refer to Figure 18). 
 
The ellipses (..) indicate that a popup panel will appear when the corresponding action is selected 
(e.g., Preview.. in Figure 19). 
  
Actions in a pull-down, which are unavailable, are dimmed and displayed in reduced contrast 
(gray). 
 
Actions, which have an associated quick selection keystroke, have the keystroke displayed on 
the right side of the pull-down (e.g., "<Ctrl > +<Delete>" in the Edit pull-down). 
 

 
Figure 18 Lesson Plan Editor Menu Bar 

 
NOTE:  In the following sections, the square brackets [ ] are used to reflect the 

actions/commands which are optional. They may or may not show on the Menu Bar, 
depending on the definition in the lpuinit.dat file specified by the user. 

 
File Pull-Down 

The File pull-down (Figure 19) allows the user to manipulate the selected (highlighted) item. This 
item can either be a lesson plan, a page or step. 
 
Directory 
The Directory.. action provides the user with a listing of the lessons coded thus far. 
 
Popup View 
The Popup View.. action calls the popup window which allows users to view all the popup pages 
created thus far and their dependencies corresponding to the created lesson pages.  
 

 
Figure 19 File Pull-Down 
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Directory.. Action 

The Directory.. action provides the user with a listing in a file or on a printer (if one is connected 
of the lessons coded thus far. The directory contains the lesson plan number, the lesson title, the 
date (month-day-year) on which the lesson was last updated, and the username who last 
modified  
the lesson. 
 

Preview.. Action 
The Preview.. action is only available on the Lesson Plan Index. Preview.. generates a summary 
of the selected lesson plan or page. The Preview.. action displays the popup panel(refer to Figure 
20). The user has the choice of obtaining the following: 
 
• a full summary of a plan or a page 
• a partial summary in text only  
or 
• a partial summary in function only 
 
then, 
 
• route the output to the printer (if one is connected)  
or 
• to the display 
 
 

 
Figure 20 Preview Popup Panel 

 



  
User Guide Lesson Plan Editor 
 

Page 27 10018802  Revision 2 
 

Use or disclosure of this document is subject to the restriction 
on the title page of this document. 

History.. Action 
The History.. action allows the user to view or print a revision history of either the selected 
lesson plan or of all lesson plans. 
 
The History.. action is only available when the Lesson Plan Index window is displayed. Selection 
of History.. displays the popup panel (refer to Figure 21). If no lesson plan is selected 
(highlighted), the default is Full history of all lesson plans/pages. The user may select the Partial 
button and enter the lesson plan number to output. 
 
In addition, the user has the option of routing the revision history to the display or to the printer (if 
one is connected). If the printer option is selected, the user may enter the number of copies to be 
printed. 
 
The revision history consists of the date of each update, the user who last made the update, and 
a description of changes made. 
 
 

 
Figure 21 History Popup Panel 

Popup View.. Action 
The Popup.. action allows the user to view the existing popup pages created thus far. The Popup 
View action provides the information of popup page number, the title and each of its dependency 
that corresponds to the lesson pages. This action is available during both Page Edit window and 
Lesson Index window. 
 

 
Figure 22 Popup View Window 
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Copy to Disk.. Action 

Selection of the Copy to Disk.. action causes the popup panel (refer to Figure 23) to appear and 
allows the user to copy the highlighted lesson plan sources to a floppy disk. 
 
This feature is used to make backups of the lesson plans onto floppy disks.  
 
The Copy to Disk.. action is also used when the user wants to transfer the coded lesson to the 
host computer for training use. It is useful for foreground updates if an Ethernet connection to 
host is not available. 
 
 

 
Figure 23 Copy to Disk Popup Panel 

 
How to Copy to Disk 
To copy the lesson plan source pages to the disk, the user should be in the Lesson Index window 
and should highlight the lesson plan, which is to be copied. Then, from the Copy To Disk popup 
panel: 
 
• Type the floppy drive name in the Copy To box and select OK button 
or  
• Double click the drive name from the directories list in the scrolling window 
 
NOTE:  A message will be displayed in a popup panel to notify the user of the status of copy: 

either the page file (pagennnn.src) has been successfully copied or an error has 
occurred if fail to copy. 
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Open Action 
Selecting the Open action opens the selected item and allows the user to modify it. This is the 
implied action when the left mouse button is double clicked on an item. 
 
If the current edit status is Lesson Plan Index window (consisting of one large scrollable list), and 
a lesson is selected, the Open action display either of the following: 
 
• Profile Edit window if it is a profile lesson 

 
• Page Edit window if it is a text lesson 
 
• Lesson Plan Sub-Index window if the multiple pages option is specified in the initialization 

file (Reference LPUINIT.DAT - Appendix A) 
 
If the current edit status is the Lesson Plan Sub-Index window, and the lesson is selected, the 
Open action displays the Page Edit window. 
 
If the selected item is a popup in the Page/Profile Edit window and Open is actioned, a Popup 
Edit window is displayed.  
 

Save Action 
Selection of the Save action saves the current lesson plan, both the page source file and the 
database file (LPDB.DAT) are updated accordingly. It is available only in the EDIT window. 
 

Close.. Action 
Close.. exits the current window and returns to the previous window. The user has the choice to 
exit with or without saving edits (refer to Figure 24). 
 

Exit.. Action 
Selection of Exit.. ends the editing session. If any modification has been done, and user selects 
Exit before saving, user will be prompted with the Close popup (refer to Figure 24). The user has 
the choice of exiting the editor with or without saving changes, or canceling the exit action and 
remaining in the current window. 
 
Upon exiting the current window, if any modifications were made and the file was saved, the user 
is requested to enter a revision history comment. 
 
 

 
Figure 24 Exit Popup Panel 
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Edit Pull-Down 
The Edit pull-down (refer to Figure 25) contains editing actions which apply to different levels of 
edited items such as lesson plans, lesson pages or lesson steps. Some of the actions will only 
appear when it is applicable (e.g., modify grid only appears when editing a profile page). 
 

 
Figure 25 Edit Pull-Down 

 
All the edit actions apply to a selected item, depending on the edit window type, for example: 
 
Index window 

→LP 
Edit window 

→ Step / Text/Popup … etc 
 
 

Modify Action 
Selecting the Modify action allows the user to change the selected item. This is the implied 
action when the left mouse button is double clicked on an item. 
 
If an item is selected via the Lesson Plan Index window and the Modify function is selected: 
 
• The Profile Edit window is displayed if it is a profile lesson 
  
• The Page Edit window is displayed if it is a text lesson 
 
• The Lesson Plan Sub-Index window is displayed if the multiple pages option is specified in 

the initialization file (Reference LPUINIT.DAT file, Appendix A – keyword: MULTI_PAGE). 
 
If the selected item is on the Lesson Plan Sub-Index window and Modify is selected, the Page 
Edit window is displayed.  
 
If the selected item is a popup in the Lesson Plan Edit window and Modify is selected, the Popup 
Edit window is displayed. 
 
NOTE:  Refer to the Section 8 for Page Edit Window and Popup Edit Window, which further 

describes the Modify action in the respective window. 
 

Cut Action 
The Cut action allows the user to copy the selected item to a temporary buffer and removes the 
item from the window. It further allows the user to Paste the cut buffer to a selected location or to 
discard the buffer. 
 

Copy Action 
Selecting the Copy action allows the user to copy the selected item to a temporary buffer without 
removing the item from the window. It further allows the user to Paste the copied buffer to a 
selected location. 
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Paste Item Action 

The Paste action copies the contents of the temporary buffer to the selected location. The item 
field is updated dynamically to reflect the current item type for the paste action. For example, it 
shows: 
 
• Paste Lesson if the item to be pasted is a lesson plan, (i.e., Paste is actioned from the 

Lesson Plan Index window.) 
• Paste Step if the content of the buffer is step. 
• Paste Text if the item to be pasted is a text string. 
• Paste Popup if the item to be pasted is a popup. 
 
NOTE: All the above edit commands (Cut/Copy/Paste) are interactive with the standard 

window’s clipboard. The user can edit between lesson plans windows and other ASCII 
editors’ window, but only text item is applied in this context. 

 
Delete 

The Delete action deletes the selected item; before the selected item is removed, a confirmation 
popup is displayed. The user has the choice to Cancel or proceed with the Delete action. 
 

Modify Grid.. [Optional] 
The Modify Grid.. action displays a popup panel (refer to Figure 26) which controls all the display 
options for the profile page.  
 
The foreground colors of the various grid components are set through the lpuinit.dat file. 
 
 

 
Figure 26 Modify Grid Popup 
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Graph Type Selection 
The Graph Type selection allows the user to modify the graph type by selecting one of the 
displayed graph types. There are four types of graphs available:  
 
• graph with one set of time and altitude axis 
• graph with altitude indication appear on both the left and right side of the vertical axis 
• graph with split grids which a discontinuity on the altitude axis is allowed 
• a graph with no altitude axis 
 
The user can also toggle the display of a grid on top of the selected profile. 
 
Altitude Axis Information 
Allows the user to modify the altitude axis title, minimum and maximum values, as well as the 
start and end of the discontinuity (if applicable) in the altitude axis. If the graph type selected is 
not a split graph, the discontinuity inputs will not be displayed. 
 
Time Axis Information 
The Time Axis information allows the user to modify the time axis title, the maximum time span 
for the training, as well as, the scale increment. 
 
Save Action 
The Save action allows the user to save the current grid definition (refer to Figure 27) in the 
lesson plan database. It can then be used as the default grid setup when creating new lesson 
plans. The user has the choice of either saving it as a new graph definition or overwriting an 
existing definition. 
 
 

 
Figure 27 Save Grid Definition Popup 

 
Help Text [Optional] 

The Help Text action is an optional action that can be specified via the LPUINIT.DAT file 
(Appendix A). It brings up a dialog that allows the user to type in the help text associates with the 
current step or button. This help text will be further used at the foreground HELP feature.  
 
The selection is available only if a step or popup item is selected. 
 

Modify Profile [Optional] 
The Modify Profile action allows the user to modify the profile popup, which is associated with 
the current lesson page.  
 

Delete Profile [Optional] 
The Delete Profile action allows the user to delete the profile popup which is associated with the 
current lesson page.  
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NOTE:  Both the Modify and Delete Profile options are only available if the “PROFILE_POPUP” 
keyword is specified in the lpuinit.dat file (Appendix A). Note that the 
PROFILE_POPUP keyword is mutually exclusive with the standard profile and popup 
pages option. 

 
 

Create Pull-Down 
The Create pull-down (refer to Figure 28) allows users to create different types of lesson plan 
items depending on the displayed window type. Some create actions are dimmed and displayed 
in reduced contrast (gray) indicating that the actions are not applicable. 
 
The LP.. action is available if the Lesson Plan Index or Lesson Plan Sub-Index windows are 
currently displayed.  
 
The Step, ATIS, CDB Label, and popup actions are available if the Page/Profile Edit window is 
currently displayed.  
 
The Button action is available if the Popup Edit Window is currently displayed. 
 

 
Figure 28 Create Pull-Down 

 
LP… Action 

The LP.. action allows the user to create a new lesson plan or page (from the Lesson Plan 
Index or Lesson Sub-index windows).  
 
The lesson plan is inserted before the selected item. Once the LP.. is selected, the user is 
prompted for the title of the lesson. The user can also choose between a text or profile lesson at 
this point. 
 
If profile lessons are available and the profile page type is selected, the Grid Selection popup is 
displayed (Figure 29). 
 
Refer to Section 8 for the Lesson Plan Index Window and the Lesson Plan Sub-Index Window 
descriptions. 
 
Grid Selection Popup 
The Grid Selection popup allows the user to define the grid setup for the newly created lesson 
plan. The user can scroll through the existing grids while viewing them in the small preview 
window (refer to Figure 29). 
 
The user can create a new grid by selecting the New Grid button, which will call up the Modify 
Grid popup. Modifying or deleting an existing grid at this point is also possible. 
 
Select the OK button to complete the Grid Selection action. 
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Figure 29 Grid Selection Popup 

 
Step Action 

While in the Profile/Page Edit window, the Step action allows the user to create a new step. The 
user can further enter the step text in the display area. The input is highlighted to identify the 
edited step text. The new step text is inserted before the selected item or at the user-selected 
cursor position if it is on a blank line. 
 

ATIS Action 
While in the Profile/Page Edit window, the ATIS action allows the user to specify ATIS static text. 
The input is highlighted to identify it as ATIS text. The text is inserted before the selected item or 
at the user-specified cursor position if it is on a blank line. The text color is defined via lpuinit.dat 
file (Appendix A). 
 

CDB Label ➤ Action 
The CDB Label ➤ action is available only if a step is currently being edited (the Step Edit 
window is displayed). The feature complements the predefined selections (FRAME.DAT - 
Appendix B), where the user can dynamically define a step, criteria, auto sequence logic, and 
variable malfunctions via CDB labels. Below are the available options: 
 
Selection…Option 
The Selection.. option allows the user to assign a value to a CDB label for the highlighted step.  
 
When it is selected, a popup panel appears allowing the user to enter the CDB label, data type 
and value. The validity of label and value are only checked according to the user defined data 
type, so the user should exercise caution before using this feature. Figure 30 shows the 
Selection CDB Label window. 
 
This value will be set when the step is activated at foreground run-time. This option is useful for a 
user who wishes to create a step function which is not available in the predefined Selections 
popup panel. 
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Figure 30 CDB Labels Selection Edit Popup 

 
Criterion…Option 
The Criterion.. option allows the user to set up a criterion condition for a step using a CDB label. 
When selected, a popup panel appears allowing the user to enter the CDB label, its value and 
direction. The label, value, and direction are not checked by the editor, so the user should 
exercise caution before using this feature. 
 
This option is useful for users who wish to set up conditional criteria which are not available in the 
predefined Criteria popup panel. 
 
Auto Sequence…Option 
The Auto Sequence.. option allows the user to set up an auto sequence condition for a step 
using a CDB label. When selected, a popup panel appears allowing the user to enter the CDB 
label, its value and direction. The label, value, and direction are not checked by the editor, so the 
user should exercise caution before using this feature. 
 
This option is useful for users who wish to set up conditional auto sequence criteria which are not 
available in the predefined Auto Sequence popup panel. 
  

Popup Action [Optional] 
The Popup action allows the user to create a new popup (in the Profile/Page Edit window). The 
user is allowed to enter the text or create button(s) within the popup display area. The input is 
highlighted identifying it as popup text. The new popup is inserted before the selected item or at 
the user specify cursor position if it is on a blank line. Refer to Section 8 for the Popup Edit 
Window description. 
 

Button Action [Optional] 
The Button action allows the user to create a new button (in the Popup Edit window, see 
Section 8). The user is allowed to enter the button text in the button display area. The input is 
highlighted to identify the button text. The new button is inserted before the selected item or at 
the user specified cursor position if it is on a blank line. 
 

Profile Action [Optional] 
The Profile action allows the user to create an associated profile popup. This option is only 
available if it is specified in the lpuinit.dat file (Appendix A). It is mutually exclusive with the 
standard profile and popup pages. 
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Tools Pull-Down 
The Tools pull-down (refer to Figure 31) provides the user with the extra tools necessary for 
editing, such as to import an existing lesson plan source file or template file, or to recover a 
source file that was inadvertently deleted or corrupted. It also provides quick and complete 
update on the lesson plans when the Frame Database is changed. 
 

 

Figure 31 Tools Pull-Down 

 
Import… Action 

The Import.. action allows the user to import a lesson plan page source file or template file for 
inclusion in the current editing session.  
 
It is commonly used to include a page source file (with all its associated popups), which are not 
part of the existing lesson plan database (LPDB.DAT). 
 
Once the Import.. action has been successfully completed, the user is required to check all the 
popups that came with this imported page file. If the popup is new to the existing pages, it must 
be opened and saved to complete process.  
 
If the popup already exists and the user does not wish to have several copies of the same popup, 
then this new popup must be deleted and re-created via the Create Popup function (see Section 
7 and 8). This allows the user to choose and associate an existing popup for the current edit. 
 
The Import.. action also allows the user to import a template lesson plan page file for inclusion in 
the editing session. This is used to include a template file to use as a base line for the lesson 
coding (e.g., to ensure that all lessons have a consistent format). 
 
Import Popup Panel Description 
 
An Open popup panel is displayed when the Import button is selected. This allows the user to 
specify the source location and the file type (i.e., either ended with src or tpl).  
 
From the popup panel, the user can select the file type (whether page sources or template file), 
then enter/select the location of the source. The popup will list all the files with the specified file 
type from the selected directory.  
 
Selecting the filename from the directory list in the scrolling window and selecting the OK button, 
or double clicking on the file (PAGEnnnn.SRC for a page source file or xxxxxxxx.TPL for a 
template file) will complete the import action, and the selected file will be included in the editing 
session.  
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Figure 32 Import Popup Panel 

 
How to Create a Template File 
To create a template file, first create a lesson page with the desired basic layout via the Editor. 
Take note of the source page number which is indicated on the session status window. Save the 
lesson and Exit the editor. 
 
Rename or copy the source file (PAGEnnnn.SRC) which will be used as a template to 
xxxxxxxx.TPL, where xxxxxxxx is a user-created mnemonic identifying the template. For 
example, to make a lesson plan page template, the user may copy PAGE0400.src (the lesson 
plan page) to BASECKLP.TPL.  
 
IMPORTANT: Once this has been done, the user must go back into the editor and delete the 

newly created lesson plan that is now is a template.  
 
When the Import action is successfully performed, the editor will assign the next available page 
number to the imported page. 
 
How to Import a Template or Source File 
Users need to be at the appropriate level of the editing session to Import a template or a source 
page for inclusion of the page.  
 
To use the template file for a new lesson plan, the user must create a new lesson plan and then 
engage the Import action from the Page/Profile window. 
 
To replace an existing lesson with the template, the user must open the lesson plan and then 
engage the Import action from the Page/Profile window. 
 

Update All Action 
The Update All action allows the user to update ALL lesson plans in the editor when the Frame 
Database is modified. This option is only available from the Lesson Plan Index Window. Editing 
a plan automatically invokes the selected plan page update using the new Frame Database. 
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Lock All Step Action 

The Lock All Step Action allows the user to lock all the steps in the lesson plan currently being 
edited. This is to avoid the possibility of steps being moved around by the Automatic Step 
Placement algorithm (see Section 8 on how to create a step), which is especially used when the 
lesson is crowded. This option is only available when editing a Profile lesson and most often used 
when importing a profile from LPE version 2.4X (using the binary FRDB.DAT frame database) or 
below, where the Automatic Step Placement feature did not exist. 
 
 

Options Pull-Down 
The Options pull-down (refer to Figure 33) allows the user to customize the editing session. 
 

 
Figure 33 Options Pull-Down 

 
Row/Column Display Action 

The Row/Column display action displays the row and column numbers along the top and left 
side of the page. This feature helps the user position the page information at a precise row and 
column. If the action is in effect, a check mark preceding the Row/column display action is 
shown. This feature is available only for text type of lesson plans. 
 

Typeover Action 
The Typeover action is used to select the mode of typing text.  
 
Selection of the Typeover action allows the user to toggle the Typeover mode. If the action is in 
effect, a check mark preceding the Typeover display action is shown. By default the editor is in 
insert mode. 
 
In insert mode, characters are inserted to the left of the cursor position and existing text after the 
cursor is shifted to the right. 
 
In Typeover mode, entering text at the cursor position causes any previous text to be overwritten. 

 
Help 

The Help pull-down (refer to Figure 34) provides context sensitive help on how to use the Editor.  
 

 
Figure 34 Help Pull-Down 

 
Index… Action 

The Index.. action displays a popup panel which lists all help topics available to the user. 
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Using Help… Action 
The Using Help.. action displays a popup panel with information on how to use the editor help 
facility. 
 

About… Action 
The About.. action displays the CAE logo window with the Editor version. 
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SECTION 7 

LESSON PLAN EDITOR TOOL BAR 
DESCRIPTION 

The following is a description of the actions available from the Tool Bar (refer to Figure 35). The 
icons within the Tool Bar represent features and functions that are commonly used, and are thus 
placed for convenient access. 
 

Close
Paste

 

Figure 35 Lesson Plan Editor Tool Bar 

 
NOTE:  Refer to Section 6 - Menu Bar for the detail descriptions of the corresponding actions.  
 

New Icon 
The New icon is used to create a new lesson and is equivalent to using the Create Pull-Down 
menu to create a Lesson Plan. This icon has no effect in the Profile/Page Edit Windows 
(i.e., while the plan is being edited). 
 

Modify Icon 
The Modify icon is used to open/modify an existing lesson, step or popup. It is equivalent to 
using the Edit Pull-Down menu from the Menu Bar to Modify an editing item. 
 

Save Icon 
The Save icon is used to save the current Lesson in the Profile/Page Edit Window and is 
equivalent to the Save function in the File Pull-Down menu. 
 

Close Icon 
The Close icon is used to exit the current window (i.e., the Page Exit Window, the Popup Edit 
Window or the Lesson Plan Index Window). The user has the choice of exiting with or without 
saving. This function is equivalent to the Close in the File Pull-Down menu. 
 

Preview Icon 
The Preview icon generates a summary of the selected lesson plan or page. It is equivalent to 
using the Preview function in the File Pull-Down menu. 
 

Delete Icon 
The Delete icon deletes the selected item. It is equivalent to the Delete function in the Edit 
Pull-Down menu. 
 

Cut Icon 
The Cut icon allows the user to copy the selected item to a temporary buffer and remove the item 
from the window. This is equivalent to using the Cut function in the Edit Pull-Down menu. 
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Copy Icon 
The Copy icon allows the user to copy the selected item to a temporary buffer without removing 
the item from the window. This is equivalent to using the Copy function from the Edit Pull-Down 
menu. 
 

Paste Icon 
The Paste icon copies the contents of the temporary buffer to the selected location. This is 
equivalent to using the Paste function in the Edit Pull-Down menu. 
 
NOTE: The four edit icons: Delete, Cut, Copy and Paste, are dimmed/not available if no item is 

selected in the Edit window. 
 

Line Icon (Profile Mode Only) 
The Line icon allows the user to draw a profile line in the Profile Edit Window. To draw a profile 
line, the user first selects the icon (in red), then uses the cursor to draw lines by left clicking the 
mouse to create the starting point, and dragging the line to the joining point(s). The line is 
terminated when the user clicks the right mouse button, or hits the <ESC> key. The line draw 
function is terminated when the user deselects the Line icon. 
 

Arrow Icon (Profile Mode Only) 
The Arrow icon allows the user to draw arrows in the Profile Edit Window. To draw an arrow, the 
user selects the icon (in red) and then uses the cursor to draw the arrow by selecting the starting 
point and then dragging the line to its next point. The arrow is terminated when the user clicks the 
right mouse button. The Arrow draw function is terminated when the user deselects the Arrow 
icon. 
 

Profile Icons (Profile Mode Only) 
The Profile icons are used to generate the profile lines automatically from the time/altitude 
information supplied by the user. Five different icons indicate its associated flight phase. 
Selecting any of the five Profile icons brings up a popup with four user-enterable fields: Start 
Time, Duration, Start Altitude and End Altitude (refer to Figure 36). The user is then required to 
supply the time/altitude information for the profile to be generated. Besides the pre-flight phase, 
the popup is brought up with default values for its starting point (taken as the ending point of the 
previous phase), thus usually requiring that the user only enter the duration and end altitude of 
the phase. 
 

 
Figure 36 Pre-flight Profile Popup 
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Pre-Flight Icon 
Selecting the Pre-Flight icon brings up the Pre-flight phase popup. The user is required to enter 
the Start Time and Duration of the Pre-Flight phase, as well as specifying its altitude in the End 
Altitude field. 
 

Climb Icon 
Selecting the Climb icon brings up the Climb phase popup. The user is required to enter the 
duration and end altitude to complete this phase profile. 
 

Cruise Icon 
Selecting the Cruise icon brings up the Cruise phase popup. The user is required to enter the 
duration of the cruise phase, as well as specify its altitude in the End Altitude field. 
 

Descent Icon 
Selecting the Descent icon brings up the Descent phase popup. The user is required to enter the 
duration and end altitude to complete the descent phase profile. 
 

Landing Icon 
Selecting the Landing icon brings up the Landing phase popup. The user is required to enter the 
duration of the landing phase, as well as specify its altitude in the End Altitude field. 
 
NOTE:  For all above selections, although the default values of start altitude and start time are 

provide, user is always allowed to alter these values, and all the profile phases will be 
adjusted automatically (the previous phase and the following phase joins are changed 
accordingly). 
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SECTION 8 

LESSON PLAN EDITOR WINDOWS  
DESCRIPTION 

The following sections describe the different window layouts used by the Editor and the different 
operating procedures for windows. 
 

Logo Window 
The first window displayed when the editor is invoked is the CAE logo window (refer to 
Figure 37). The CAE logo window contains the following information: 
 
• CAE logo 
• Name of the Utility, Lesson Plan Editor 
• Editor Version Number 
• Name of the Company 
 
An OK button appears at the bottom of the Logo Window allowing users to close the window. 
 
 

 
Figure 37 CAE Logo Window 
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Lesson Plan Index Window 
After the logo window is removed by selecting the OK button, the Editor prompts the user to enter 
their name or initials. The user's name or initials identifies who created or updated the lesson. 
The Editor now displays the Lesson Plan Index Window (refer to Figure 38). 
 

 
Figure 38 Lesson Plan Index Window 

 
The first row is the Title Bar, which shows the Editor's name and window title. 
 
The second row is the Menu Bar, which provides the pull-down commands and functions 
available to the user. The unavailable options are dimmed or display reduced contrast. 
 
The Tool Bar appears below the Menu Bar and provides icons for various frequently used 
functions. 
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The Lesson Plan Index occupies the main client area of the display. It consists of: 
 
• lesson plan number 
• Lesson title  
• username of the person who last modified the related plan 
• the date (month-day-year) of the last update 
 
If the information displayed in this window exceeds the window size, a vertical Scroll Bar is 
available for the user to scroll the contents of the index into view. 
 
The lower portion of the screen shows the Session Status Window which displays information 
about the present editing session.  
 

Lesson Plan Index Window Operation 
To select an index item, single click the left mouse button on the respective lesson plan, and the 
selected lesson plan is highlighted.  
 
Most of pull-down commands from the Menu Bar and the icon actions from the Tool Bar are 
available at this window level.  
 

To Create a Lesson Plan 
To create a lesson plan, the user must perform the following: 
 
• click on the desired lesson plan number from the index window, the blank line is highlighted 
• then select LP… from the Create pull-down of Menu Bar 
 or 
• select New icon from the Tool Bar 
 
The user is prompted, with the Create LP popup (refer to Figure 6), to enter a lesson plan title 
and select the lesson type (Text or Profile). The Lesson Plan Sub-Index or Page/Profile Edit 
window is then displayed. 
 

To Modify an Existing Lesson Plan 
To modify an existing lesson plan, the user must perform either of the following: 
 
• double click on an index item where a lesson already exists 
or  
• single click on the item and selects Modify from the Edit pull-down or select Modify icon 

from the Tool Bar directly 
 
In either case, the Lesson Plan Sub-Index window is displayed for multiple page lesson plans, or 
the Page/Profile Edit window is displayed for single page lesson plans. 
 

To Copy a Lesson Plan 
To copy a lesson plan, the user must select one of the following: 
 
• select an index item  
• the Copy command from the Edit pull-down  
or  
• the Copy icon from the Tool Bar 
 
A copy of the selected plan is copied into a temporary buffer.  
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Then select the following: 
 
• the destination of the copied information (blank line/empty plan) 
• Paste from the Edit pull-down of the Menu Bar. This pastes the information contained in the 

temporary buffer (i.e., the lesson to be copied) to the selected destination. The user is 
requested to enter a new title. 

 
NOTE:  If the specified lesson plan has any associated popups, they are treated as linked 

popups, i.e., new copies to these popups are not created. 
 

To Delete a Lesson Plan 
To delete a lesson plan, the user click on the item and selects Delete from the Edit pull-down, 
or the Delete icon from the Tool Bar. The quick key-stroke is <Ctrl >+ <Delete>. The user is 
prompted with the confirmation popup. 
 
NOTE:  See Section 6 for a detailed description of Edit Pull-Down from the Menu Bar. 

Related information on the Tool Bar’s icons can be found in Section 7. 
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Lesson Plan Sub-Index Window [Optional]  
If a lesson plan is coded into multiple pages, selecting an item from the Lesson Plan Index 
window will display the Lesson Plan Sub-Index window (refer to Figure 39). It consists of the 
following: 
 
• Title Bar 
• Menu Bar 
• Tool Bar  
 
The sub-index is displayed in the client area of the display. It shows the page number and the 
page title. 
 
To select an index item, single click the left mouse button on the respective lesson plan page. 
Most of the pull-down commands from the Menu Bar are available at this level. 
 
 

 
Figure 39 Lesson Plan Sub-Index Window 

 
NOTE:  The lesson plan sub-index window is available only if the user specifies 

“MULTI_PAGE” key-word in the lpuinit.dat file (Appendix A). Be aware that this feature 
and the profile lesson (or “STD_PROFILE” keyword for lpuinit.dat file) are mutually 
exclusive. In other words, the MULTI_PAGE option only applies to text type of lesson 
plans. 
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To Create a Sub-Lesson Plan Page 
To create a Lesson Page under the Sub-Index window, the user selects a line and LP.. from the 
Create pull-down or the New icon from the Tool Bar. The user is requested to enter a page title. 
If a sub-index item is selected, the newly created plan page is inserted above the selected item. 
The Page Edit window is displayed. 
 

To Modify a Lesson Plan Page 
To modify an existing Lesson Plan Page, the user either double clicks on a sub-index item 
(implied action is Modify), or single clicks on the sub-index item and selects Modify from the Edit 
pull-down or the Modify icon from the Tool Bar. In all cases the Page Edit window is displayed. 
 

To Copy a Lesson Plan Page 
To copy a page, the user selects a sub-index item and Copy from the Edit pull-down or the Copy 
icon from the Tool Bar. A copy of the selected page is stored in a temporary buffer. Selecting a 
line and Paste from the Edit pull-down copies the temporary buffer of the lesson page to the 
selected item. 
 
NOTE:  If the specified lesson plan has any associated popups then they are treated as linked 

popups, i.e., new popup pages are not created. 
 

To Delete a Lesson Plan Page 
To delete a page, the user selects the page from the sub-index area and Delete from the Edit 
pull-down or the Delete icon from the Tool Bar. The user is requested to confirm the action in a 
popup prompt. 
 
 
NOTE:  All the edit command procedures are similar to those in the main Index window except 

that multiple lesson pages are now created under a single plan; the plan number is the 
user-selected item from the main Index window before the Sub-Index display. 
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Page Edit Window  
If the lesson type is set to Text, this window is available, to edit or create a Text lesson page from 
the Lesson Plan Index (or for multiple page lessons, the Lesson Plan Sub-Index window) and 
displays the Page Edit window as shown in Figure 40. The Page Edit window allows the user to 
define the steps in the lesson. 
 

 
Figure 40 Page Edit Window 

 
The Title Bar shows the Editor's name and the title of the window. It is followed by the Menu Bar 
and the Tool Bar with its corresponding Icons which are applicable for Text Lesson. The Display 
window/client area shows the page layout as it will appear at the instructor station. This is the 
area where the user may edit the displayed information on the page, allowing the user to place 
the step and its associated text.  
 
If the user selects a step item, the Step Edit window will be displayed with the Selections, 
Criteria, and Auto Sequence list boxes and associated controls. The Selections box lists the 
parameters available for the selected step. The Criteria box displays the criteria to be satisfied to 
trigger the step logic, and the Auto Sequence box displays the criteria, if any, to action the step 
(optional). 
 
The Status pane is at the bottom of the screen. It includes the row/column position of the cursor 
and the page source number of the lesson being edited.  
 
The following sections describe both the Page Edit and Step Edit windows. 
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Page Edit Window Operation 
In the Page Edit Window, the user can type plain text or create and modify the text associated 
with the page title, steps, and ATIS messages. 

  
To Modify Page Title 

To modify the title, the user simply positions the cursor on the title field and types the changes. In 
the editor, the title field is normally of a different color from the rest of the text on the page. 
 

To Enter Static Text 
To type in plain informative text, the user positions the cursor at a blank line and types in the 
information. The text is displayed in the default static text color. 
 

To Create a Step 
To insert a step in a Text lesson, the user positions the cursor at the desired location in the Page 
Edit window and selects Step from the Create pull-down.  
 
Depending on whether the page is for a non-touch or touch-based instructor station, a step 
number or a touch box is displayed to the left of the step text. The user may enter text in the 
touch box. 
 
Double clicking on a step or selecting the step and Modify from the Edit pull-down causes the 
Step Edit window to appear and display any parameter selections, criteria, and auto sequence 
information associated with the step. 
 

To Modify/Create Help Text 
To modify or create Help text, the user positions the cursor on the desired step in the Page Edit 
window and actions Help Text from the Edit pull-down. The Help Text Window appears, and the 
user may now enter the text associated with the respective step. 
 

Step Edit Window 
The Step Edit window contains the selections, criteria, and auto sequence logic associated with 
a selected step in the Page Edit window (refer to Figure 41) and also the Profile Edit window. 
The Step Edit window contains a Parameter Selection list box, a Criteria list box, an Auto 
Sequence list box, and all the related controls. 
 



  
User Guide Lesson Plan Editor 
 

Page 51 10018802  Revision 2 
 

Use or disclosure of this document is subject to the restriction 
on the title page of this document. 

 

Figure 41 Step Edit Window 

 
The Parameter Selections box lists all the simulation controls available i.e., whatever is coded in 
the INIT_FRAME (e.g., aircraft parameters, malfunctions, environmental parameters…etc.), 
required to define the selected step. The Criteria box lists the criteria at which the items in the 
Selections box will be activated/triggered during simulation run-time. The Auto Sequence list box 
lists the trigger to automatic sequencing to action the step.  
 
Clicking an item from the Parameter Selection, Criteria, or Auto Sequence boxes highlights the 
item. Any subsequent actions will then affect the highlighted item (refer to Sections 6 and 7 for 
the details of editing).  
 
Modifying an item in the Parameter Selection, Criteria, or Auto Sequence boxes (either by double 
clicking the item, or selecting the item and executing the Modify option from the Edit pull-down) 
allows the user to modify the value of the item via the Input popup panel. 
  
The Previous Set and Next Set buttons allow the user to change the current set of 
criteria/selections within the step. The Set # field displays the current set number. 
 
The Parameter Selection.. button allows the user to specify up to 60 selections. Pressing the 
Parameter Selection.. button displays a panel as shown in Figure 42. 
 
The Criteria.. button allows the user to specify more than one criteria, the number of criteria is 
specified in the lpuinit.dat file (Appendix A). The AND and OR buttons may be used to select 
whether the multiple criteria should be AND'ed or OR'ed. The default is OR. Pressing the 
Criteria.. button displays a popup panel as shown in Figure 49. 
 
The Auto Sequence.. button also allows the user to specify multiple auto sequence criteria. The 
AND and OR buttons may be used to select whether the multiple criteria should be AND’ed or 
OR’ed. The default is OR. Pressing the Auto Sequence.. button displays the popup panel as 
shown in Figure 51. These panels are described in the following sections. 
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Main Selection Menu 
The Main Selection Menu is displayed when the user presses the Parameter Selection.. button 
in the Step Edit window. The Main Selection Menu allows the user to specify the parameters 
required to build the selected step. The items in the panel are grouped by function (refer to Figure 
42). To remove the Main Selection Menu, the user clicks anywhere outside the menu. 
 

 

Figure 42 Typical Selections Popup Panel 

 
Parameter Selection Popup Panels 
The following describes the typical parameter popup panels available. To enter a value in the 
parameter selection, the user first selects the parameter of interest. 
 
Initial Conditions Popup Panel  
The Initial Conditions (IC) parameter selection popup panel (refer to Figure 43) contains the 
parameters which are normally used in an initial conditions step. The IC popup can also call 
another popup, such as Quick set. The user may make use of the DEFAULT to update all the 
predefined default values. Alternatively, the user may individually select parameters and set their 
values.  
 
NOTE: DEFAULT button is not available unless DEFAULT_SET keyword is specified in the init 

file, also the DEFAULT value(s) for the required selection must be correctly coded in the 
frame database. Refer to Appendix B for the detail. 
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Figure 43 Typical Initial Conditions Popup Panel 

 
 
Malfunction Systems Popup Panel 
The Malfunctions popup panel allows the user to select a system to fail (refer to Figure 44). 
Selection of a system displays the detailed list of malfunctions for the related system in the lower 
half of the Malfunction Systems Popup Panel. 
 

 
Figure 44 Typical Malfunction Systems Popup Panel 
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Other System Popup Panels 
Some standard system popups available for the step selection are: 
 
• Environmental Conditions 
• Visual Controls 
• Aircraft Conditions 
• Repositions  
• Freeze/Resets 
• Miscellaneous 
 
Figure 45 shows an example of the Environmental Condition Popup. It allows the user to select 
environmental conditions such as QNH and wind. Users are able to organize their parameter 
selection popups in any way desired; usually these selections are structured as per the LCD 
page tree (Refer to FRAME.DAT - Appendix B). 
 

 
Figure 45 Typical Parameter Selection Panel 

 
Input Popup Panel 
When the user wishes to modify any value previously entered, the Input popup panel is used. 
From the Step Edit window the user can select to modify the controls available in the following 
dialogs: 
 
• Parameter Selections 
• Criteria 
• Auto Sequence 
 
A left mouse double click on a parameter displays the Input popup with applicable controls 
available depending on the datatype of the selected parameter. 
 
An example of a discrete datatype is Total Freeze. In this case, only the ON/OFF buttons are 
made available (refer to Figure 46). 
 

 
Figure 46 Sample Discrete Input Popup Panel 
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Environmental parameters, such as Runway Visual Range (RVR) and visibility, are examples of 
numeric parameters. In this case, the user can input the value in the value box or use the slider 
(refer to Figure 47). The minimum and maximum values of the parameter are displayed above 
the slider. 
 
 

 
Figure 47 Sample Numeric Input Popup Panel 

 
Windshear selection consists of multiple selections which are mutually exclusive, and the values 
are specified through a list as shown in Figure 48. 
 
The Delay set (optional) input allows the user to delay the activation of other steps after the 
current one is actioned. 
 
After inputting the value, the user selects the OK button to accept the value. The Cancel button 
closes the window without taking the input. 
 

 
Figure 48 Sample Multiple Input Popup Panel 
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Criteria Selection Popup Panels 
The Criteria Selection popup panel is displayed when the user selects the Criteria.. button in 
the Profile/Page Edit window. The Criteria popup panel allows the user to associate trigger 
criteria to the selected step (refer to Figure 49). 
 
 

 
Figure 49 Sample Criteria Popup Panel 

 
Selecting a criterion in the Criteria popup panel highlights that criterion and allows the user to 
specify a value for it (Figure 50). Depending on the selected criterion type (i.e., discrete or 
variable), some controls in the Criterion Popup Panel are enabled or disabled. 
 
 

 
Figure 50 Criterion Input Popup Panel 
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For a variable criterion, like altitude, the user may either input the value via the slider or type into 
the value box directly. The minimum and maximum values of the parameter are displayed above 
the slider. The user must also select one of the criteria direction buttons (Decreasing, Equal To or 
Increasing). 
 
For discrete criteria, only the ON, OFF, and Criteria direction buttons are enabled. Criteria 
direction is entered using the following format: 
 
For variable criteria: 
 

Equal To when the criterion value crosses the value specified from either above or 
below, the criterion is satisfied. 

 
Increasing when the criterion value crosses the value specified from below, the criterion 

is satisfied. 
 
Decreasing when the criterion value crosses the value specified from above, the criterion 

is satisfied. 
 
For discrete type criterion: 
 

Equal To when the criterion value goes ON or OFF 
 
Increasing  when the criterion value goes from OFF to ON 
 
Decreasing  when the criterion value goes from ON to OFF 

 
The user can also choose whether the criteria value entered is an absolute value or relative to 
the current value of the respective parameter. The user can select the choice via the Relative to 
current value checkbox from the criterion popup. (Figure 50) For example, the step could be 
triggered at an altitude of 1000 ft or at an altitude of (current altitude + 1000 ft). 
 
If multiple criteria are specified on the step, the AND or OR button in the detail window is used to 
specify whether the criteria should be AND’ed or OR’ed. 
 
Criteria can be modified from the Step Edit window by double clicking on the required criterion. 
This action brings up the Criterion Input Popup Panel shown in Figure 50, where the criterion 
can be edited. 
 

Auto Sequence Selection Popup Panel 
The Auto Sequence Selection popup panel is displayed when the user selects the Auto 
Sequence.. button in the Step Edit window. The Auto Sequence popup panel allows the user to 
specify the criteria used for auto sequencing from the current step to the next step (refer to 
Figure 51). 
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Figure 51 Sample Auto Sequence Popup Panel 

 
Selecting an item in the Auto Sequence popup panel highlights that item and allow the user to 
specify a value (refer to Figure 52). Depending on the selected item type (i.e., discrete or 
variable), some controls in the Auto Sequence popup panel are enabled or disabled. 
 
The coding of Auto Sequencing is exactly like Criterion selection as described in the previous 
section. 
 
The difference between Criterion and Auto Sequence Selection is with the action it triggers. The 
Criterion selection applies the trigger condition to activate the step’s logic, whereas the Auto 
Sequence applies the trigger condition to action the next step. 
 

 
Figure 52 Auto Sequence Input Popup Panel 
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Profile Edit Window 
Editing or creating a profile lesson page from the Lesson Plan Index displays the Profile Edit 
window as shown in Figure 53. A lesson profile provides a graphical overview of the current 
lesson in terms of an altitude versus time. 
 
The Profile Edit window provides the same functionality as the Page Edit window, as well as the 
tools required to draw the lesson profile. Also, in this mode, the Lesson Plan Editor provides the 
option of Automatic Step Placement (automatic creation and placement of steps in a lesson). A 
horizontal Scroll Bar is available on the edit window since profile lesson pages scroll along the 
time axis (if required). 
 

 
Figure 53 Profile Edit Window 
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Profile Edit Window Operation 
In the Profile Edit window, the user can type in plain informative text or create and modify text 
associated with the page title, steps, popups, and ATIS messages. The user can also draw lines 
and arrows. 

  
To Draw a Profile Line 

To draw a profile line, the user actions the Line icon from the Tool Bar and then uses the cursor 
to draw lines by selecting the starting point and then dragging the line to its next point. The line is 
terminated when the user clicks the right mouse button. The line draw function is terminated 
when the user deselects the Line icon. 
 
The user may also use one of the Profile Draw icons in the Tool Bar. The user actions one of 
the icons depending on the phase required (e.g., Pre-flight, Climb, Cruise). The user then enters 
the parameters (time and altitude) in the Profile Popup (refer to Figure 36) that appears and 
selects OK. The profile is drawn automatically.  
 
Profile phases can be modified by double clicking on the profile line.  
 
The Profile Popup appears and the user must enter the new time/altitude values and select OK. 
The Profile is then redrawn with the new Profile values. If the phase being modified is connected 
to other phases, then these phases too will be adjusted accordingly. As an example, if the Cruise 
phase where raised from an altitude of 10 000 to 15 000, the adjacent Climb and Descent will be 
raised to meet the Cruise phase at the new altitude. 
 
NOTE:  The detail description of the Profile Icons are provided in Section 7 
 

To Draw an Arrow 
To draw an arrow, the user actions the Arrow icon from the Tool Bar and then uses the cursor to 
draw the arrow by selecting the starting point and dragging the line to its next point. The arrow is 
terminated when the user clicks the right mouse button. The arrow draw function is terminated 
when the user de-selects the Arrow icon. 
 

To Create a Popup 
To insert or create a popup button, the user positions the cursor at the desired location in the 
Profile Edit window and actions Popup from the Create pull-down.  
 
The Popup Control Window (refer to Figure 54) appears for user inputs. 
 
Double clicking on an existing popup button or selecting it and actioning Modify from the Edit pull-
down menu causes the Popup Edit Window (refer to Figure 55) to appear for user input. Then the 
user may enter the text associated with that popup or create direct input buttons. 
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Figure 54 Popup Control Window 

Popup Control Window 
The Popup Control Window allows the user to create a new popup, copy an existing one, or link 
the current popup button to an existing popup. The window displays a list of existing popup 
pages, as well as their dependency to the lesson pages. Existing popups with no dependency 
can be deleted if no further link is needed. 
 
Users have the choice of using an existing popup in one of the following ways: 
 
• Copy – a duplicate popup page is created. 
• Link – a new link is created to the same popup page. 
 
Or, select New to create new popup page. 
 
Once the inputs are completed and OK is selected, the Popup Edit Window appears. (Figure 55) 
 
Popup Edit Window 
Selecting a popup button from the Profile Edit window, displays the Popup Edit Window as 
shown in Figure 55. In the Display window, the user can type in plain informative text or create 
and modify the text associated with a button or the page title.  
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Figure 55 Popup Edit Window 

  
A popup page can be used to provide the instructor with additional information, as well as a 
choice of input buttons.  
 
The Popup Edit window provides the same functions as the Page Edit window, except the 
buttons created are not part of the normal lesson plan sequence. The instructor must always 
select them manually. 
 
The user has the ability to re-size the popup window to a desired height and width, as well as the 
ability to move the popup to a specific location relative to the profile lesson page. The Popup 
Edit window Title Bar provides a running status of the popup size and location. 
 
Re-sizing The Popup 
The popup window can be re-sized by dragging its border in the desired direction with the mouse. 
It can be re-sized in two directions at once by dragging the corner of the popup window. 
 
Moving the Popup 
Dragging the Title Bar with the mouse moves the popup window. 
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To Modify Page Title 
To modify the title, the user positions the cursor on the title field and types in the changes. In the 
editor, the title field is normally of a different color from other text on the page. 
 

To Enter Static Text 
To type in plain informative text, the user positions the cursor at a blank line and types in the 
information. The text is displayed in the default static text color. 
 

To Create a Step 
To create a step, the user clicks at the desired location on a Profile phase (the profile should turn 
red) and actions Step from the Create pull-down (refer to Section 6). This brings up the Step 
Edit Window with the Phase Information filled in. The window also shows the step number of the 
step created (refer to Figure 56). 

Phase Info

Lock  Switch

Step Number

 

Figure 56 Step Edit detail Window 

 
Double clicking on a step or selecting the step Modify function from the Edit pull-down causes 
the Step Edit window to appear and display any selections, criteria, and auto sequence 
information associated with the step. 
 
The Phase Information in the Step Edit Window is based on the position within the profile where 
the user clicked (this includes the phase, time and altitude). The user may alter any of these 
values as required. Selecting the Phase button shows a list of all phases currently in the lesson 
plan, and allows the user to choose one. The user can also modify the time/altitude of the step by 
modifying one or the other (the corresponding one is calculated automatically). Note that the time 
field is based on the number of minutes INTO the selected phase. 
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The user can then choose the selections for the step in the same manner outlined earlier in 
Section 8. When the CLOSE button is selected, the step is automatically placed near its 
requested position on the profile (as specified by the time/altitude parameters) and an arrow is 
drawn connecting it to the profile. Note that the creation of new steps may move some existing 
ones to make room. 
 
Should a user manually move a step, it becomes LOCKED, meaning that it will not be moved in 
the future even if new steps require it to do so. The user may UNLOCK a step by double clicking 
on the step and toggling the Lock Switch. The Automatic Placement algorithm only handles and 
moves steps that are marked UNLOCKED. 
 
The user does not need to select a profile when creating a step. By selecting Step form the 
Create pull-down brings up the Step Edit Window allowing the user to create a step with the 
required selections. This step is considered LOCKED and is, therefore, not moved by the 
Automatic Placement algorithm. Should the user later decide to have the step handled by the 
Auto Placement algorithm, the user must draw an arrow connecting the step to the profile at the 
required position and toggle the Lock Switch in the Detail Window. 
 
An existent (UNLOCKED) step can be moved by double clicking on it and changing its time or 
altitude in the Detail Window. The Auto Placement algorithm will make room for it near the profile 
and then move it automatically (with its arrow). Selecting the Phase button and choosing a new 
phase from the phase list changes the step’s phase altogether. 
 
Note that deleting a Profile Line will delete ALL steps associated with that phase.  
 

To Modify/Create Help Text 
To modify or create Help text, the user positions the cursor on the desired step in the Profile Edit 
window and actions Help Text from the Edit pull-down. The Help Text Window appears, and 
the user may now enter the text associated with the respective step. 
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SECTION 9 

ABBREVIATIONS LIST 
 
#, No  : Number 
A/C  : Simulated Aircraft 
ATIS  : Automatic Terminal Information Service 
ATA  : Air Transportation Association 
CB  : Circuit Breaker 
CDB  : Common Database 
CRT  : Cathode Ray Tube 
CSC  : Computer Software Component 
CSU  : Computer Software Unit 
FRDB  : Frame Database 
ft  : Foot (Feet) 
ftp  : File Transfer Protocol 
GUI  : Graphical User Interface 
IC  : Initial Condition 
in  : Inch(es) 
IOS  : Instructor Operator Systems 
kg  : Kilogram(s) 
kt  : Knot(s) 
lb  : Pound(s) 
LCD  : Liquid Crystal Display 
LPE  : Lesson Plan Editor 
LPU  : Lesson Plan Utilities 
LRU  : Line Replaceable Unit 
lt  : Light 
m  : Meter(s) 
min  : Minute(s) 
N/A  : Not Applicable 
nm  : Nautical Mile(s) 
PC  : Portable Computer 
s, sec  : Second(s) 
SDD  : Software Design Document 
sw  : Switch 
RVR  : Runway Visual Range  
UG  : User Guide 
TBD  : To Be Determined 
TIGERSTM : The Interactive Graphics Environment for Real-Time Systems(Trade Mark) 
V  : Volt(s) 
wrt  : With Respect To 
EC  : Degree(s) Celsius 
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APPENDIX A 

STANDARD LESSON PLAN UTILITY  
INITIALIZATION FILE 

The following describes the Lesson Plan Editor initialization file which by default is located in the 
directory from which the editor is run. The full path to the initialization file may be specified on the 
command line if the initialization file is not in the default directory. The file is called LPUINIT.DAT. 
 
A sample LPUINIT.DAT file is shown below. 
 

 

  !--- Sample LPU Init file 
  ! 
  ! --- Source file path 
  ! 
  SRCPATH 'c:\lpe\src\'; ! source page path 
  FRDBPATH 'c:\lpe\src\'; ! FRAME.DAT file path (Frame Database) 
  LPDBPATH 'c:\lpe\src\'; ! LPDB.DAT file path (Lesson Plan Database) 
  ! 
  ! 
  ! --- Valid lesson page numbers 
  ! 
  VALIDPAGE RANGE=401:899; 
  ! 
  ! --- Page Attributes 
  ! 
  PAGE_ATTRIB 
    ROW=150,        ! row dimension 
    COLUMN=65,       ! column dimension 
    TITLE_COLOR=WHITE,  ! page title color (optional) 
    STATIC_COLOR=GREEN, ! static page color (optional) 
    MAX_LESSON=100,    ! Maximum Number of Lesson Plans 
    MAX_PAGE=40,      ! Max No. of Pages in Lesson Plan 
    SIZE=2,         ! Character size for volatile info 
    CHARSIZE=10,      ! Character size for static info 
    CHARWIDTH=20,     ! Character width for static info in pixels 
    CHARHEIGHT=27,    ! Character height for static info in pixels 
    NO_CONDITION,     ! To specify no color condition 
                !  on lesson step (optional) 
    DEFAULT_SET,     ! Default step type SET not TOGGLE (optional) 
    MAXCRITEMS=10,    ! max # SV items allowed with criteria 
    HEADER=21,      ! use header page 21 (optional) 
    SIM_TOUCH,      ! create page using touch blocks 
    DISPLAY_SET,     ! display 'SET' when active 
    SRC_NUMBER,     ! include source file number 
    SERIAL_PORT='COM1', ! Serial line to host port 
    MULTI_PAGE,      ! Multiple page lesson plan 
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Source File Path 
The SRCPATH command specifies the page source file directory. 
 
Format: SRCPATH 'directory 
 

Lesson Plan Database File Path 
The LPDBPATH command specifies the lesson plan database directory. The lesson plan 
database contains information about the lesson plans, such as their titles, who last updated them, 
etc. for use by the utility. 
 
Format: LPDBPATH ‘directory’ 
 

Frame Database File Path 
The FRDBPATH command specifies the frame database file directory. The frame database file 
contains information about the Lesson Plan Editor frames. 
 
Format: FRDBPATH 'directory' 
 

  ! 
  ! --- Touch Box Attribute Setup 
  ! 
  TOUCH_BOX       ! For Touch simulators 
   WIDTH=5,        ! Number of columns in touch box 
   HEIGHT=3,       ! Number of rows in touch box 
   STCOL=5,        ! Start col number for touch box 
   TYPE=2000;       ! Touch Type number to specify box shape 
  ! 
  ! --- Atis message attribute setup 
  ! 
  ATIS_ATTRIB 
     COLOR=WHITE,   ! ATIS message color (optional) 
     LABEL=TLDUMGEN; ! dummy label to color ATIS 
  ! messages 
  ! 
  ! --- Step attribute setup 
  ! 
  STEP_ATTRIB 
     ACTIVE=GREEN,    ! Actioned step color 
     INACTIVE=WHITE,   ! Non-actioned step color (optional) 
     CONDITION=TLSELECT, ! Color condition CDB label 
     ACT_LABEL=TLACTN,  ! auto sequencing CDB label 
     CURRENT=YELLOW;  ! Current step color (optional) 
  ! 
  ! --- New lesson.step label 
  ! 
  NEWSTEP LABEL=TLNST; 
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Valid Lesson Page Numbers 
The VALIDPAGE command assigns the LCD page numbers available to be used for lesson plan 
pages. 
 
Format: VALIDPAGE RANGE=nnn:mmm; 
 
where nnn:mmm is a range of CRT page numbers.  
 

Valid Popup Page Numbers 
The POPUP_PAGE command assigns the LCD page numbers available to be used for popup 
pages. 
 
Format: POPUP_PAGE RANGE=nnn:mmm; 
 
where nnn:mmm is a range of CRT page numbers.  
 

Valid Profile Popup Page Range [optional] 
The PROF_POPUP_PAGE command assigns the LCD page numbers available to be used for 
profile popup pages under text lesson. This keyword is used in conjunction with 
PROFILE_POPUP. 
 
Format: PROF_POPUP_PAGE RANGE=nnn:mmm. 
 
Where nnn:mmm is a range of CRT page numbers. 
 

Valid Profile Page Range Number [optional] 
The PROFILE_PAGE RANGE command assigns the LCD page numbers to be used for profile 
lesson when SPLIT_RANGES feature is enabled and user wishes to have both types of lesson 
plan pages clearly defined into two different ranges. When this command is used, the 
TEXT_PAGE RANGE definition is mandatory. 
 
Format: PROFILE_PAGE RANGE = nnn: mmm; 
 
where nnn:mmm is the range assigned to the profile lesson, and it has to be valid within the 
VALIDPAGE RANGE. 
 

Valid Text Lesson Range Number [optional] 
The TEXT_PAGE RANGE command assigns the LCD page numbers to be used for text lesson 
when SPLIT_RANGES feature is enable when users wish to have both type of lesson plan pages 
clearly defined into two different ranges. When the command is used, the PROFILE_PAGE 
RANGE definition is mandatory. 
 
Format: TEXT_PAGE RANGE = nnn:mmm; 
 
where nnn:mmm is the range assigned to the text lesson, and it has to be valid within the 
VALIDPAGE RANGE. 
 
 

NO_USE_FREE_PAGE 
Generates the lesson plan page number based on the lesson plan index number and the lesson 
start page range. 



  
User Guide Lesson Plan Editor 
 

Page 69 10018802  Revision 2 
 

Use or disclosure of this document is subject to the restriction 
on the title page of this document. 

Page Attributes 
The P/AGE_ATTRIB command allows the user to set up the attributes of the lesson plan pages. 
 
Format: 
 

PAGE_ATTRIB 
ROW = row no., 
COLUMN = column no., 
[TITLE_COLOR = color,] 
[STATIC_COLOR = color,] 
[TEXT_COLOR = color,] 
[DEFAULT_ACT = color,] 
[DEFAULT_INA = color,] 
MAX_LESSON = n, 
MAX_PAGE = n, 
SIZE = n, 
CHARSIZE = n, 
CHARWIDTH = n, 
CHARHEIGHT = n, 
[NO_CONDITION,] 
[NO_AUTO_SEQ,] 
NO_VARMALF, 
DEFAULT_SET, 
MAXCRITEMS = n, 
[HEADER = n,] 
SIM_TOUCH, 
STD_PROFILE, 
[PROFILE_POPUP,] 
DISPLAY_SET, 
SRC_NUMBER, 
ALLOW_RELATIVE, 
USER_DELAYSET, 
[SERIAL_PORT = serial_port,] 
[MULTI_PAGE,] 
[VG45_PAGES,] 
[USE_DEF_COLOR,] 
[GEN_AUTO_TEST,] 
[AUTOSAVE = n,] 
[CRIT_NOTEQUAL,] 
  
[MAX_AUTO_TEXT = n,] 
[AUTO_PROFILE_OFF,] 
[MAX_CRITERIA=n,] 
[DISPLAY_DATE,] 
[LATLON_FORMAT,] 
[SLASH_DISABLE,] 
[PAGE_LEVEL,] 
[SINGLE_COLUMN,] 
[SPLIT_RANGES;] 

 
where: 
 
ROW = row no. is the dimension of the lesson pages by row. 
 
COL = column no. is the dimension of the lesson pages by column, maximum is 80 for text 

lesson plan. 
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TITLE_COLOR = color is the page title color. The colors available are defined in the Page 
Compiler Utility Initialization File (PGCINIT.DAT). 
 
STATIC_COLOR = color is the static page color. The colors available are defined in the Page 
Compiler Utility Initialization File (PGCINIT.DAT). 
 
TEXT_COLOR = color is the message text page color. The colors available are defined in the 
Page Compiler Utility Initialization File (PGCINIT.DAT). 
 
DEFAULT_ACT = color is the default page active color. The colors available are defined in the 
Page Compiler Utility Initialization File (PGCINIT.DAT). 
 
DEFAULT_INA = color is the default page inactive color. The colors available are defined in the 
Page Compiler Utility Initialization File (PGCINIT.DAT). 
 
MAX_LESSON = n is the maximum number of lesson plans allowed on the system. 
 
MAX_PAGE = n is the maximum number of pages allowed in each lesson plan. 
 
SIZE = n is an index number corresponding to a number in the PPCINIT.DAT file which defines 
the size, height increment, and width increment of the characters used to display volatile 
information on the lesson plan pages. 
 
CHARSIZE = n is an index number of the character size to use for static information on the 
lesson plan pages. 
 
CHARWIDTH = n specifies the inter-character spacing in pixels for static information on the 
lesson plan pages. 
 
CHARHEIGHT = n specifies the inter-line spacing in pixels for static information on the lesson 
plan pages. 
 
NO_CONDITION specifies that color conditions are not required on the lesson plan steps. 
 
NO_AUTO_SEQ specifies that auto sequence criteria are not required. 
 
NO_VARMALF specifies that ramp type variable malfunctions are not required. 
 
DEFAULT_SET specifies the default step type is SET.  
 
MAXCRITEMS = n is the maximum number of items allowed on a lesson step which has 
CRITERIA coded. 
 
HEADER = n is the header page number which will appear with the lesson plan pages. 
  
STD_PROFILE specifies that the Instructor Station supports profile lesson plans. 
 
PROFILE_POPUP specifies that the Instructor Station supports profile popup pages. The 
std_profile option must be enabled for this feature to work. 
 
DISPLAY_SET specifies that the string SET should be displayed when the lesson step is active. 
 
SRC_NUMBER specifies that the CRT page number (source file number) should be displayed on 
the lesson plan pages. If specified, the number appears in the upper left corner of the page. 
 
ALLOW_RELATIVE specifies that the Instructor Station support relative criteria. 
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USER_DELAYSET allows the user to add/modify delay set values for each item within a step. 
  
MULTI_PAGE specifies whether the lesson is divided into multiple pages or consists of one 
scrollable page. Note that “STD_PROFILE” option must be disabled. 
  
USE_DEF_COLOR forces the Lesson Plan editor to use the Windows color scheme. 
 
GEN_AUTO_TEXT creates auto-generated text when a selection is made. 
 
AUTOSAVE = n specifies the frequency at which an automatic save will occur. The editor will 
automatically save the current page every n seconds. 
 
CRIT_NOTEQUAL adds the “Not Equal” option to the criteria. 
  
MAX_AUTO_TEXT = n specifies the maximum number of auto generated selections displayed. 
 
AUTO_PROFILE_OFF inhibits the Auto Placement feature. Enabling this feature removes the 
Phase of flight feature, as well as, the Next/Previous Set entry dialog. 
 
MAX_CRITERIA=n, specifies the maximum number of criteria that can be used simultaneously. 
 
DISPLAY_DATE saves the date and time information to the source page in Profile Lesson Plans. 
This information will be displayed on the IOS station and positioned to the right of the title. 
  
SLASH_DISABLE inhibits the use of the “/” character for text input in the Lesson Plan Editor. 
  
SPLIT_RANGES allocates the two types of lesson plan pages into two separate ranges as long 
as the ranges are defined within the global VALIDPAGE range. 
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Touch Box Attribute Setup 
The TOUCH_BOX command defines the attributes for the touch block size, position, and type, if 
the simulator is a touch type simulator. 
 
Format: 
 

TOUCH_BOX 
WIDTH = no. of columns, 
HEIGHT = no. of rows, 
STCOL = touch box start column number, 
TYPE = nnnn; 

 
where: 
 
WIDTH = no. of columns is the number of columns for the touch box width. 
 
HEIGHT = no. of rows is the number of rows in touch box 
 
STCOL = touch box start column number is the start column number for touch box 
 
TYPE = nnnn is the touch type number to specify box shape as outlined in the post page 
compiler file PPCINIT.DAT. 
 

ATIS Message Attribute Setup 
The ATIS_ATTRIB command defines the attributes for ATIS messages. 
 
Format: 
 

ATIS_ATTRIB 
[COLOR = color,] 
LABEL = cdblabel; 

 
where: 
 
COLOR = color is the static color of all ATIS messages. The colors available are specified in the 
Page Compiler Utility initialization file (PGCINIT.DAT). 
 
LABEL = cdblabel is a common database dummy label used to color ATIS messages. 
 

Step Attribute Setup 
The STEP_ATTRIB command allows the user to define the active and inactive colors of the 
lesson plan steps. 
 
Format: 

STEP_ATTRIB 
[ACTIVE = color,] 
[INACTIVE = color,] 
  
CONDITION = cdblabel, 
ACT_LABEL = cdblabel, 
[CURRENT = color;] 
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where: 
 
ACTIVE = color is the color which lesson plan steps will color when actioned. The colors 
available are specified in the Page Compiler Utility initialization file (PGCINIT.DAT). 
 
INACTIVE = color is the color which lesson plan steps will color when not yet actioned. The 
colors available are specified in the Page Compiler Utility initialization file (PGCINIT.DAT). 
  
CONDITION = cdblabel defines the CDB label to be coded to handle the color condition for the 
lesson plan steps. 
 
ACT_LABEL = cdblabel defines the CDB label to be coded to handle auto sequencing steps. 
 
CURRENT = color is the color which lesson plan steps will color when they are the current step 
of interest. The colors available are specified in the Page Compiler Utility initialization file 
(PGCINIT.DAT). 
 

  
Profile Attributes 

The PROF_ATTRIB command allows the user to set up the attributes of the profile lesson plan 
pages. 
 
Format: 
 

PROF_ATTRIB 
BCKGRD_COLOR = color, 
LINE_COLOR = color, 
ARROW_COLOR = color, 
BORDER_COLOR = color, 
GRID_COLOR = color, 
TIME_BAR, 
TIME_BAR_LABEL = label, 
TIME_BAR_COLOR = color, 
LINE_WIDTH = n, 
[ARROW_WIDTH = n,] 
[TIME_ALT_REMIND,] 
[USE_FLVL,] 
AREA =(STROW = n, ENDROW = n, STCOL = n, ENDCOL = n); 
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where: 
 
BCKGRD_COLOR = color is the background color of the graph area. The colors available are 
specified in the Page Compiler Utility initialization file (PGCINIT.DAT). 
 
LINE_COLOR = color is the color of the profile lines. The colors available are specified in the 
Page Compiler Utility initialization file (PGCINIT.DAT). 
 
ARROW_COLOR = color is the color of the arrow lines. The colors available are specified in the 
Page Compiler Utility initialization file (PGCINIT.DAT). 
 
BORDER_COLOR = color is the color of the graph border. The colors available are specified in 
the Page Compiler Utility initialization file (PGCINIT.DAT). 
 
GRID_COLOR = color is the color of the grid. The colors available are specified in the Page 
Compiler Utility initialization file (PGCINIT.DAT). 
 
TIME_BAR specifies that an elapsed time bar should be displayed below the profile graph. 
 
TIME_BAR_LABEL = label defines the CDB label to be coded to drive the elapsed time bar. 
 
TIME_BAR_COLOR = color is the color of the elapsed time bar. The colors available are 
specified in the Page Compiler Utility initialization file (PGCINIT.DAT). 
 
TIME_BAR_WIDTH = n specifies the width, in pixels, of the elapsed time bar when it is displayed 
at the instructor station. 
 
LINE_WIDTH = n specifies the width, in pixels, of the profile line when it is displayed at the 
instructor station. 
 
ARROW_WIDTH = n specifies the width, in pixels, of the arrow lines when they are displayed at 
the instructor station. 
 
TIME_ALT_REMIND causes a reminder popup to appear if the user does not provide 
Time/Altitude information when creating a step. 
 
USE_FLVL allows the user to specify if the grid in the Profile Lesson Plan will be displayed in 100 
Ft or 1000 Ft increments. If this keyword is not specified then the grid will be displayed in 1000 Ft 
increments. 
 
AREA = .. specifies the area of the profile graph. The width of this area MUST be a multiple of 12. 
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Popup Attributes 
The POPUP_ATTRIB command allows the user to set up the attributes of the popup pages. 
 
Format: 
 

POPUP_ATTRIB 
[ACTIVE = color,] 
[INACTIVE = color,] 
WIDTH = no. of columns, 
HEIGHT = no. of rows, 
[STCOL = touch box start column number,] 
TYPE = nnnn; 

 
where: 
 
ACTIVE = color is the default active color for the popup page. The colors available are specified 
in the Page Compiler Utility initialization file (PGCINIT.DAT). 
 
INACTIVE = color is the default active color for the popup page. The colors available are 
specified in the Page Compiler Utility initialization file (PGCINIT.DAT). 
 
WIDTH = no. of columns is the default number of columns for the popup window. 
 
HEIGHT = no. of rows is the default number of rows for the popup window. 
 
TYPE = nnnn is the touch type number to specify box shape as outlined in the post page 
compiler file (PPCINIT.DAT). 
 
 

Help Attributes 
The HELP_ATTRIB command allows the user to set up the attributes of the help information. 
 
Format: 
 

HELP_ATTRIB 
WIDTH = no. of columns,  
HEIGHT = no. of rows, 
NO_CONDITION; 

where: 
 
WIDTH = no. of columns is the default width of the help information popup window. 
 
HEIGHT = no. of rows is the default height of the help information popup window. 
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APPENDIX B 

FRAME DATABASE USER GUIDE 
The Frame Database contains the information needed by the Lesson Plan Editor to process the 
selection of lesson step functions, and to subsequently create page source files using the 
function selection made. 
 

Volatile Selection Commands 
The Lesson Plan Editor has four types of volatile selections for a lesson plan function: Value, 
Input, Predetermined Set, and Malfunction. 
 
Value Input selections are those which require the user to specify a value which is to be set 
when the function is selected. An example of a value input selection is the selection of Wind 
Speed. The user must specify the wind speed value. 
 
Predetermined Set selections are those which do not require the user to enter any values - the 
value(s) to set have been previously determined. The user needs only to choose the selection 
and it will be set to the predetermined value when the lesson step is executed. An example of a 
predetermined set selection is TOTAL RESET. The user needs only to indicate that a total reset 
is to be actioned. 
 
Malfunction selections are generated automatically from an ASCII file source. 
  
The instructions to specify the volatile characteristics of a function are described in the following 
sections. The instructions contain all the information required for the Lesson Plan Editor to 
process the selection when editing is being done, and to subsequently create the corresponding 
SET VALUE item(s) when the lesson page is coded. 
 
ITEMS enclosed in square brackets in the following descriptions are optional. 
 
Note that the selections should have a unique NAME since the Lesson Plan Editor refers to them 
by their NAME. 
 
NOTE: Malfunction selections are typically generated from an ASCII data file that lists all failures 

available from all aircraft systems. 
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SETVALUE (Predetermined Set) Instruction 
The SETVALUE instruction defines a selection which will cause one or more predetermined 
values to be set into the common database when the function is selected. 
 
Format: 
 

/SETVALUE 
NAME = node_id 
TEXT = title description, 
ITEM = (LABEL = cdblabel, VALUE = value[,DELAYSET = 

delayset][,DELAYRESET]) 
 [,HELP = “help text”] 

/ 
 

Where: 
 
NAME = node_id - specifies the selection’s unique name, entered as a string in single quotes. 
The maximum length is 15 characters. 
 
TEXT = title description - specifies the selection title, entered as a text string in single quotes.  
 
ITEM = (LABEL = cdblabel, VALUE = value[,DELAYSET = delayset][, DELAYRESET]) 
 
LABEL = cdblabel - specifies the CDB label name to be set. Care should be taken to ensure that 
the CDB label is valid. 
 
VALUE = value - specifies the value to which the CDB label should be set when the function is 
actioned. 
 
DELAYSET = delayset - specifies the time in seconds after which the ITEMS' label is set to the 
value specified. 
 
DELAYRESET - indicates that the ITEM'S value should be reset after a two second delay. 

 
Up to 60 ITEMs may be specified in a single SETVALUE instruction. 
 
  

DECIMAL (Value Input) Instruction 
The DECIMAL instruction defines a selection that requires the user to enter a value, which will be 
used to set a specific label in the common database when the function is selected. 
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Format: 
 

/DECIMAL  
NAME = node_id 
TEXT = title description, 
FORMAT = format, 
LABEL = cdblabel, 
[,MAXIMUM = maxval] 
[,MINIMUM = minval] 
[,SCALE = scale_fact] 
[,TRANSLATE = trans_fact] 
[,DEFAULT = deflt_val] 
[,MISC = misc_code] 
[,NO_DECIMAL] 
[,DELAYSET = delayset] 
[,DELAYRESET] 
[,STORE_RADIAN] 
[,HELP = “help text”] 

/ 
 

Where: 
 
NAME = node_id - specifies the selection’s unique name, entered as a string in single quotes. 
The maximum length is 15 characters. 
 
TEXT = title description - specifies the selection title entered as a text string in single quotes. 
 
 
FORMAT = format - specifies the value type expected. These include the following: 
 
ALPHANUMERIC  A 
ANGLE    D 
INTEGER   X 
LATITUDE    SXX:XX:XX / SXX:XX:XX.X 
LONGITUDE    SXXX:XX:XX / SXXX:XX:XX.X 
REAL    X.X 
TIME    HH:MM:SS 
 
Even if the CDB label is declared as a real, the data type of the frame may be defined as integer, 
if an integer value is wanted. To determine the data type, refer to the CRT page source file 
containing the label and look at the display format or refer to the CDB. 
 
LABEL = cdblabel - specifies the CDB label which will be set when the function is selected. Care 
should be taken to ensure that the CDB label is valid. 
 
DEFAULT = deflt_val - specifies the default value for this selection. This value must be in the 
same data format as the value type (specified by TYPE). 
 
MINIMUM = minval - specifies the minimum input value of the volatile before scaling, when the 
value type is numeric (real, integer, or time). The minval must be the same format as the value 
type specified. When the value type is alphanumeric, the minimum specifies the minimum 
number of characters the user may enter. 
 
MAXIMUM = maxval - specifies the maximum input value of the volatile before scaling, when the 
value type is numeric (real, integer, or time). The maxval must be the same format as the value 
type specified. When the value type is alphanumeric, the maximum specifies the maximum 
number of characters the user may enter. 
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Minimum and maximum values can also be specified for the type TIME. The valid format is 
HH:MM:SS. 
 
Note that if one MINIMUM or MAXIMUM is specified, the other must also be specified. 
 
SCALE = scale_fact - specifies the scale factor by which the volatile’s value is multiplied before it 
is displayed to the user. For example, to code a fuel weight (kg) entry on the editor frame, a scale 
factor for Pounds to kg (0.454) is required, since the CDB units are pounds. The scale factor is 
always specified as a real number. 
 
TRANSLATE = trans_fact - specifies the translation factor by which the volatile’s value is 
translated before it is displayed to the user. For example, to translate an input value from 
Fahrenheit to Celsius, both a SCALE factor and a TRANSLATE factor must be used. The 
translation factor is always specified as a real number.  
 
NOTE:  The scale factor is always applied to the value before the translation factor.  
 
Scale/translation factor is used when the user inputs values in different units from those specified 
in the CDB for the label. 
 
MISC = misc_code - specifies a miscellaneous page coding string of keywords for the selection. 
This string is used directly as part of the set value instruction. It is not processed, but the page 
compiler will use it. This is useful for adding a delay before a label is updated in the CDB, like a 
delay reset; or to update another associated Boolean label that must be changed at the same 
time as the present value input. The string must be surrounded by single quotes, and can be a 
maximum of 100 characters long. 
 
For example, to specify an associated Boolean to set with a value input such as Gross Weight, 
the user would specify: 
 
MISC = 'ITEM = (LABEL = TCMGWAU, VALUE = ON, DELAYRESET)' 
  
DELAYSET = delayset - specifies the time in seconds after which the label is set to the value 
entered. 
 
DELAYRESET - indicates that the label value should be reset to zero after a two-second delay. 
 
STORE_RADIAN - implies as a similar option for STORE_RADIAN for page editing in VIEWS. It 
indicates that this decimal value will be stored in radian i.s.o. of degree. It applies only for bearing 
and lat-lon format where radian is needed instead of degree. This transformation is transparent to 
users, where the details of selection still being represented as lat-lon or Degree format in the 
editor’s user interface. 
 

BOOLEAN (Value Input) Instruction 
The BOOLEAN instruction defines a selection that requires the user to enter a value, which will 
be used to set a specific label in the common database when the function is selected. The 
BOOLEAN instruction is identical to the DECIMAL instruction, except that the FORMAT, 
MAXIMUM and MINIMUM fields are neglected since the instruction is of a BOOLEAN type. 
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Format: 
 

/BOOLEAN  
NAME = node_id, 
TEXT = title_description, 
LABEL = cdblabel, 
[,DEFAULT = deflt_val] 
[,MISC = misc_code] 
[,DELAYSET = delayset] 
[,DELAYRESET] 
[,HELP = “help text”] 

/ 
Where: 
 
NAME = node_id - specifies the selection’s unique name, entered as a string in single quotes. 
The maximum length is 15 characters. 
 
TEXT = title_description - specifies the selection title entered as a text string in single quotes. 
 
LABEL = cdblabel - specifies the CDB label which will be set when the function is selected. Care 
should be taken to ensure that the CDB label is valid. 
 
DEFAULT = deflt_val - specifies the default value for this selection. This value must be in the 
same data format as the value type (specified by TYPE). 
 
MISC = misc_code - specifies a miscellaneous page coding string of keywords for the selection. 
This string is used directly as part of the set value instruction. It is not processed, but the page 
compiler will use it. This is useful for adding a delay before a label is updated in the CDB, like a 
delay reset; or to update another associated Boolean label that must be changed at the same 
time as the present value input. The string must be surrounded by single quotes, and can be a 
maximum of 100 characters long. 
 
For example, to specify an associated Boolean to set with a value input such as Gross Weight, 
the user would specify the following: 
 
MISC = 'ITEM = (LABEL = TCMGWAU, VALUE = ON, DELAYRESET)' 
 
DELAYSET = delayset - specifies the time in seconds after which the label is set to the value 
entered. 
 
DELAYRESET - indicates that the label value should be reset to zero after a two-second delay. 
 
 

MALF (Malfunction) Instruction 
The MALF instruction defines a selection containing one or more Value Inputs (BOOLEAN and/or 
DECIMAL) grouped together for convenience. These selections must be actioned separately. 
 
Format: 
 

/MALF 
NAME = name, 
TEXT = title, 
SYSTEM = (LABEL = cdblabel, NAME = name [, FORMAT = format] [, MINIMUM 

= minval] [, MAXIMUM = maxval] [, SCALE = scale_fact] 
 [,TRANSLATION=0, BOOLEAN=TBXXXXXX] 
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/ 
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Where: 
 
NAME = name - specifies the selection’s unique name, entered as a string in single quotes. The 
maximum length is 6 characters. 
 
TEXT = title - specifies the selection title entered as a text string in single quotes. 
 
SYSTEM = (LABEL = cdblabel, NAME = name[, FORMAT = format][, MINIMUM = minval] 
 [,MAXIMUM = maxval][, SCALE = scale_fact]) 
 
LABEL = cdblabel - specifies the CDB label which will be set when the function is selected. Care 
should be taken to ensure that the CDB label is valid. 
 
NAME = name - specifies the sub-system’s name, entered as a string in single quotes. The 
maximum length is 9 characters. 
 
FORMAT = format - specifies the value type expected (same as per DECIMAL instruction). 
 
MINIMUM = minval - specifies the minimum input value of the volatile before scaling, when the 
value type is numeric (real, integer, or time). The minval must be the same format as the value 
type specified. When the value type is alphanumeric, the minimum specifies the minimum 
number of characters the user may enter. 
 
MAXIMUM = maxval - specifies the maximum input value of the volatile before scaling, when the 
value type is numeric (real, integer, or time). The maxval must be the same format as the value 
type specified. When the value type is alphanumeric, the maximum specifies the maximum 
number of characters the user may enter. 
 
Minimum and maximum values can also be specified for the type TIME. The valid format is 
HH:MM:SS. 
 
Note that if one of MINIMUM or MAXIMUM is specified, the other must also be specified. 
 
SCALE = scale_fact - specifies the scale factor by which the volatile’s value is multiplied before it 
is displayed to the user. For example, to code a fuel weight (kg) entry on the editor frame, a scale 
factor for Pounds to kg (0.454) is required, since the CDB units are pounds. The scale factor is 
always specified as a real number. 
 
TRANSLATION=0, This keyword is required only as a standard keyword for VIEWS editor, it is 
not applicable to malfunction in lesson plan system and the parser will bypass the value. 
 
BOOLEAN = TBXXXXXX – is only applied to variable malfunction systems when the actual 
engineering unit is applied, then the TB label exist. 
 
NOTE: In the previous version, lpu supports the TB label under MISC keyword, and this is no 

longer applicable. Where currently the LPU’s parser recognizes this syntax format of TB 
label under malfunction input file, the user does not have to modify the malf.lib manually 
when TB label is required. 

 
Each malfunction frame can have up to 150 selections. 
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Frame and Category Definitions 
Lesson Plan Editor selection instructions can be grouped together into logically related sets. 
 
A Frame Database FRAME groups together a set of selections of a specific type, or for a specific 
system. These selections will be displayed together as a Lesson Plan Editor Selection Frame. 
For example, ENVIRONMENT, AIRCRAFT, ELECTRIC MALF.. 
A Frame Database CATEGORY groups together a set of mutually exclusive selections. For 
example, DAY/DUSK/NIGHT can be a group. 
 

START_FRAME Instruction 
The START_FRAME instruction is used to group a set of selections into a single Frame 
Database FRAME. All selections following the START_FRAME instruction will be displayed when 
the Lesson Plan Editor accesses this frame. A frame grouping is terminated by the END_FRAME 
instruction.  
 
Format: 
 

/START_FRAME  
NAME = name, 
TEXT = title 
[,INIT_FRAME] 
[,IC_FRAME] 
[,CRIT_FRAME] 
[,MALF_FRAME] 

/ 
 
Where: 
 
NAME = node_id - specifies the selection’s unique name, entered as a string in single quotes. 
The maximum length is 15 characters. 
 
TEXT = title description - specifies the frame title, entered as a text string in single quotes.  
 
INIT_FRAME - indicates that this frame is the Initialization Frame that is to be used by the Lesson 
Plan Editor. This frame will contain the links to all the other frames. 
 
IC_FRAME - indicates that this is the Initial Condition frame, and therefore is displayed with the 
controls only applicable to IC. 
 
CRIT_FRAME - indicates that this is the Criteria frame, and is to be accessed via a special button 
control. 
 
MALF_FRAME - indicates that the frame is a MALFUNCTION frame, it can be arranged either 
displayed by ATA chapter which is default or flight phase. 
 
Note that a maximum of 100 frames may be created, and a maximum of 150 selections may be 
defined for each frame (for a maximum of 15 000 entries). 
 

END_FRAME Instruction 
The END_FRAME instruction is used to signal the end of a Frame grouping. The END_FRAME 
instruction is only allowed if a previous START_FRAME instruction was encountered. 
 
Format: 
 
 /END_FRAME/ 



  
User Guide Lesson Plan Editor 
 

Page 84 10018802  Revision 2 
 

Use or disclosure of this document is subject to the restriction 
on the title page of this document. 

START_MENU (Start Category) Instruction 
The START_MENU instruction is used to group a set of selections into a single Frame Database 
CATEGORY. All selection instructions following the START_MENU instruction will be considered 
elements of a category grouping. Only SETVALUE selections are allowed in a category grouping. 
A category grouping is terminated by the END_MENU instruction. 
 
The category group is meant for selections which have predefined value, and are mutually 
exclusive. 
 
No two elements of a category may be selected at the same time. If one category element has 
already been selected, the selection of another element will cancel the first. 
 
Format: 
 
 /START_MENU 
  NAME = name, 
  TEXT = title 
 / 
 
Where: 
 
NAME = node_id - specifies the selection’s unique name, entered as a string in single quotes. 
The maximum length is 15 characters. 
 
TEXT = title description - specifies the category title entered as a text string in single quotes. The 
maximum title length is 40 characters. 
 

END_MENU (End Category) Instruction 
The END_MENU instruction is used to signal the end of a category grouping. The END_MENU 
instruction is only allowed if a previous START_MENU instruction was encountered. 
 
Format: 
 
 /END_MENU/ 
 
There can be more than one category per file. 
 
NOTE: The MENU (Category) instruction is only allowed to be coded in the ‘catsel.lib’, and is 
prohibited in ‘frame.dat’. 
 

 Object Instruction 
The OBJECT instruction allows the user to reference a selection that has been previously defined 
in the database. 
 
Format: 
 
 /OBJECT 
  NAME = name 
 / 
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Where: 
 
NAME = name - specifies the selection’s unique name, entered as a string in single quotes. The 
maximum length is 15 characters. 
 
The OBJECT being referenced can be a FRAME, SETVALUE, DECIMAL, BOOLEAN or MENU. 
The use of the OBJECT instruction means that the same selection does not need to be coded 
twice. As well, when OBJECT is used, and the selection is made from one editor frame, it will 
show up as selected on any other frame where it is also used. When OBJECT is not used, the 
editor cannot recognize that the same selection has already been made. 
 
 

Using the Frame Database 

The Frame Database information is the collections of node(s), menu(s), and frame(s) in the 
structure briefly described in the following paragraph. Figure 57 shows the graphical 
representation of all the components involved in frame database. 
 
The main file FRAME.DAT is a sequential access file. It contains the nodes instructions, frames 
definition and also object references. Both the CRIT_FRAME and INIT_FRAME should be coded 
in this file. The init_frame or the INDEX FRAME contains the links to other frames at highest 
level, similar to a main menu. All the frame selections within this init_frame are object referenced 
to the regular frames or malfunction frames. 
 
 

FRAME DAT.

CRIT FRAME INIT_FRAME

FRAMES

MALF_FRAMES

MALF NODES

MALF.LIB

NODES OBJECTS

MENUS

REFER.LIB

CATSEL.LIB

Legend: Filename

Instruction
Definition

 
Figure 57 Frame Database 
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Any object can be referenced within the same file or from other libraries. If it is within the same 
file, the user should ensure that the frames are coded properly and exist before the references. 
This rule also applies to any kind of selection. 
 
User can easily find any missing object reference from the error listing file “frame.err” after 
running lpu. 
 
The following three libraries are part of the standard in frame database which complements the 
frame.dat: 
 
1) The REF.LIB file – contains selections that are frequently used, therefore may be referenced 

by more than one frame. 
 
2) The CATSEL.LIB – is a library of all the Category Selections (MENUs) used in the Database. 

This category must not be coded anywhere else other than in this library. 
 
3) The MALF.LIB library – contains all the MALFUNCTIONS used in the Database. This file 

comes directly from the malfunction group, and is similar to Addendum 1. Malfunctions are 
usually grouped by ATA. 

 
  
Modifying the Frame Database 

When changes are made to any of the frame database files: FRAME.DAT, REFER.LIB, 
CATESEL.LIB or MALF.LIB, the pages must be updated if the changes affects the page 
selection. 
 
The user can run the Update All option from the Tool pull-down menu. This action will 
automatically update all the selections on all the existing pages. The user may also re-open only 
the page(s), which were affected by the changes and save them manually, since re-invoking the 
editor after a frame database update uses the latest database information. Re-saving the page 
enforces the selections update. The items to be affected by the update process are the CDB 
labels and assigned value changes. 
 
 


